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1 GETTING STARTED 

 

This section provides start-up instructions for using the Oracle Cloud applications. 

 

1.1 Sign-On to Cloud applications  

To log into the application:  

1.  Open internet browser window. Any browser can be used to access Cloud Application. 

2. Enter the URL below: 

No. URL Type URL Link 

1.  UAT  https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com 

2.  PROD https://fa-etei-saasfaprod1.fa.ocs.oraclecloud.com 

Table 1: Direct Login URL 1 

 

3. The Sign In page appears. Enter your User ID and Password.  

 

Figure 1: Oracle Cloud Sign-In Page 1 

4. Your user ID and password are case sensitive. Passwords always appear as asterisks 
in the display as you enter them.  

5. Tab to or click the  button to sign in. 

6. Personal Homepage dashboard screen appears with CLOUD privilege access. 
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1.2 Navigating from Personal Home Page to Applications 

After you log in to Oracle Applications, your Oracle Financial Cloud Home page is displayed. 
All the functionality within the Oracle Cloud applications revolves around homepage which you 
can personalize. From here you can: 

1. Get a quick glance at your work-related conversations and announcements. 

2. Use the Application Link icons to navigate to pages and dashboards to perform your 
day-to-day activities.  

3. Access the Navigator to access any additional applications that are not available in the 
application section on the home page 

4. Favourited list of quick actions to quickly perform some key tasks. 

 

Note: 

The exact appearance of your windows may vary depending on your personalization and roles 
that is assign to you. 

 

Figure 1: Personal Home Page 

 

 

 

 

 

 

Figure 3: Navigation tools in the global area of the home page 
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Once you have set your homepage as the Newsfeed Home Page, then it will come with 
different sections. 

 

1. Apps Section  

 

Figure 4: Apps section 

 

Within the Apps section, you have various icons that can be used to start navigating into 
the different work areas of an application. For example, if you would like to navigate to the 
Invoices work area within Payables, you will select your application as Payables. And you 
will choose Invoices in the Apps section. When you select Invoices, the system takes you 
to the Invoices work area, where you can perform various activities, such as recording 
invoices, managing invoices, generating accounting for your invoices, etc. Once your work 
has been completed, you can go back to the home page by using the home icon. 

You can also access the apps via the Navigator.  

Here, the access is granted to various work areas based on the roles that have been given 
to your user account. You have the flexibility to personalize the App section. You can 
decide what you want to show within these springboard icons and what you want to hide. 
If you are an order regular visitor to the Payment work area, you mostly work with 
Payable’s dashboard invoices, you can hide the payments by clicking on this icon. So, it 
will not be shown in the apps icon but only accessible through the Navigator. 

 

2. Things to Finish section  

 

Figure 5: Things to Finish section 

The Things to Finish section provides you with a count of any pending notifications that 
are assigned to you and may require an action from you. Account Link name created 
by me lists the approval requests that you have created. You can click the link to 

Click this to 
personalize 
springboard 
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navigate to a full list of notifications pertaining to that account. Then the items listed in 
the Things to Finish section are same as the notifications that are listed in the global 
header.  

The same information is available when you click on notifications icon. You can access 
the same number of notifications from here, as well as from the Things to Finish 
section. The list displays the latest notification first and allows you to scroll horizontally 
to view more notifications.  

You can clear a notification from the list by clicking the Close icon. When you clear a 
notification, the count does not change, since no action is taken on that notification. If 
you click on you will get a listing of all the notifications that are either FYI or the 
notifications that require an action from you. When you click on the link it opens the 
notification and you can get the details of the notification. If you are satisfied, you can 
either approve it or you can either reject it. Once the notification is read then the count 
will change. 

 

3. Analytics section  

 

Figure 6: Analytics section 

 

As far as financials is concerned, there are currently 5 choices of analytics display. 
And they are cash management infolet, general accounting infolet, source to settle 
infolet, service infolet, and order to cash infolets. You can personalize the Analytics 
section and decide which infolet should be visible, which should not be visible.  

 

1.3 Creating Favorites and Setting Preferences  

Creating Favorites 

Each user has their own favorites and adding favorites is easy in cloud: just go to your favorite 
work area or task page. Click on the favorite icon and click Add to Favorites.  By this you get 
to your favorite pages directly and easily when you click the favorite icon. You can remove 
unwanted pages by clicking Manage Favorites. 

 

Click on this icon to either 
hide or display a particular 

infolet. 

Infolets 



Olivestouch Technologies Sdn Bhd 
User Manual 

Payables Module v1.0 

 

Confidential  Page 8 of 112 

 

 

 

 

Figure 7: Creating and Managing Favorites 

 

Set Preferences 

Select Preferences to set personal options such as regional, language, accessibility setting, 
watchlist and etc as shown in the list in Figure 8. You can also reset your password from the 
Preferences page. To get into set preferences, click on setting and action dropdown menu 
click on Set Preferences. 

 

Figure 8: Setting Preferences 
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1.4 Overview of Using Work Areas to Streamline Business Processes 

Use work areas to gain instant insight into your business and identify potential problems with 
processing transactions.  

Work areas can include the following: 

 

• Infotiles 

• Content area 

• Actions toolbar 

• Tasks panel tab 

• Search panel tab 

• Reports and Analytics panel tab 

 

 

 

 

 

Figure 9: Invoice Work Area (Payables) 
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Infotiles 

Summarize a high volume of transactional information. You can quickly identify potential 
problems and prioritize your daily activities by scanning the infotiles and accessing transaction 
details. 

For example, select an infotile to display corresponding transactional information in the content 
area. You can also click links in the infotile to filter the records in greater detail in the content 
area. 

 

Content Area 

The content area displays transactional information related to the infotile you select. You can 
review the detailed information and take the necessary action. 

For example, click the item link in the table to drill down to transaction-level information. You 
can perform multiple actions on the transaction, such as editing the invoice, approving, or 
rejecting the transaction, and posting the invoice to the ledger. 

 

Actions Toolbar 

Use the actions toolbar to perform a range of activities on one or more rows you select in the 
content area. 

For example, select a transaction row and use the View menu to view the transaction in more 
detail. You can export the data to an Excel worksheet, detach the pane, approve, or reject one 
or more transactions, as well as apply additional filters. 

 

Tasks Panel Tab 

The Tasks panel includes tasks that are related to the work area and that you have access to 
perform. 

For example, create an invoice, review journal entries, create mass additions, and manage 
accounting periods within a task panel. 

 

Search Panel Tab 

Search enables you to find a specific transaction using search criteria related to the work area. 

For example, search on an invoice number or supplier in the Invoices work area to find a 
specific transaction. 

 

Reports and Analytics Panel Tab 

The Reports and Analytics panel tab contains predefined reports as well as a folder for you to 
set up your own reports. 

For example, use the predefined reports to perform a deeper analysis on invoices above a 
certain dollar amount without a PO. You can also access reports that you have copied and 
modified and stored in your own folder. 
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1.5 Scheduled process 

Scheduled processes do tasks that are too complex or time-consuming to do manually, for 
example importing data or updating many records. You can run scheduled processes on a 
recurring schedule and send notifications based on how the process ends. Some scheduled 
processes give you printable output. Those processes might have Report in their name. 

 

Jobs  

Each scheduled process that you run is based on a job. The job is the executable that controls 
what the process can do and what parameters and other options you have for the process. A 
job set contains multiple jobs. 

Job definitions can be set on Oracle Business Intelligence Publisher reports so that people 
can run the reports as scheduled processes. 

 

Process Sets 

A process set is a scheduled process that is based on a job set. So, when you submit a 
process set, you are running more than one job. 

Note: When you submit certain scheduled processes, the job logic causes other processes to 
automatically run. But in this case, you are not submitting a process set that includes those 
other processes. 

 

Submission 

When you submit a scheduled process, you can use its parameters to control which records 
are processed and how. Some scheduled processes do not have parameters. 

As part of the submission, you can also set up a schedule for the process, for example to run 
once a week for two months. Every time a process runs, there is a unique process ID. 

 

Output 

Some scheduled processes provide output in PDF, HTML, and other formats. For example, a 
process can import records and produce output with details about those records. There are 
many types of output, for example a tax document or a list of transactions. 

 

Process Sets 
A process set is a type of scheduled process that is based on a job set and contains at least 
two processes. So, you can run many processes in one go, for a specific purpose. These 
processes run in a certain order, in serial or parallel, or by some other logic.  
Process sets can have any number of individual scheduled processes and even other 
process sets.  
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To Submit Scheduled Processes 
 
Click Navigator > Tools > Scheduled Processes. 
 

 
Figure 10: Scheduled Processes Overview Page 

 
1. On the Scheduled Processes Overview page, click Schedule New Process. 

2. Leave the type as Job, enter the process that you want to submit, and click OK. 

3. In the Process Details dialog box, enter at least the required parameters, if any. ‘ 

 
Some processes have no parameters at all. Some parameters depend on other 

parameters. For example, date range parameters might appear only after you select 

By Date for another parameter. 

 
4. Click the Advanced button if you want to define the schedule, notifications, or 

output. Continue to the next steps. Or just skip to the steps for  

5. Click Submit, to run the process once as soon as possible with the default output. 

 
Define the Schedule 
Set up a schedule to run the process on a recurring basis or at a specific time. Use the 
Process Details dialog box in Advanced mode. 
 

1. Open the Schedule tab and select Using a schedule for the Run option. 

2. Select a frequency. 

3. Select User-Defined if you want to enter the exact dates and times to run the 

process. 

4. You can select Use a Saved Schedule to use an existing schedule if there are any. 

5. Depending on the frequency, define when the process should run. 

 
Define the Output 
You can choose the layout, format, and destination for your output. Use the Process Details 
dialog box in Advanced mode. 
 

1. Open the Output tab, if available. 

2. Click Add Output Document. 

3. Change the name if you want. The name identifies this output document when you 

go to view output later. 
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4. Select a layout if you have more than one to choose from. 

5. Select a format, for example one of these: 

 
PDF: Is the best option if you want to print the output. 

Excel: Supports embedded images, such as charts and logos, but can be opened 

only in Excel 2003 or higher. 

Data: Gives you report data in an XML file, which is used mainly for editing the report 

layout. 

 
6. Click Add Destination to send the output somewhere, for example to a printer or 

email address. You can add many destinations and send the output to all of them at 

the same time. 

 
Tip: You can also print the output as part of the steps for finishing the submission, 

instead of adding a printer destination here. 

 

To add more output documents, repeat steps 2 to 6. 

 
Set Up Notifications 
You can have notifications sent out depending on how the process ends. Use the Process 
Details dialog box in Advanced mode to set that up. 
 

1. Open the Notification tab. 

2. Click Create Notification. 

3. In the Recipient field, enter the user ID of the person you want to send the 

notification to. 

4. In the Condition list, select when to send the notification, for example when the 

process ends in error. 

5. Click OK. 

 
To send notifications to more people, repeat steps 2 to 5. 
 
Finish the Submission 
Follow these steps in the Process Details dialog box: 
 

1. Click the Process Options button if you want to define settings that affect the data to 

be processed. 

2. If the process gives you output and you want to print it, select the Print output check 

box and a printer. 

3. Select the Notify me when this process ends check box if you want to get an email 

notification. 

4. Enter submission notes to capture any information you want to associate with this 

submission. You can use your notes to find this submission later. 

5. Click Submit. 

6. Click OK to confirm. 

 
Tip: Note down the process ID for your submission so you can easily find it later. For 
example, let's say you set the process to run once a week. If you later want to cancel all runs 
on this schedule, you need to cancel this original submission with this process ID. 
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To Submit Process Sets 
 
To submit a process set from the Scheduled Processes Overview page: 
 

1. Proceed with the steps that you would follow to submit any scheduled process, but 

select Job Set for the Type option. 

2. In the Process details dialog box, set parameters for individual processes in the set. 

A process set itself does not have parameters. 

a. Select a process on the Processes tab. 

b. Enter parameters for that process, if any. 

c. Repeat for other processes in the set. 

3. Define the schedule, output, and notifications for the process set, as you would do for 

any scheduled process. 

4. Set any other options and click Submit. 

 
To Check Status 
 

1. Click Navigator > Tools > Scheduled Processes. 
The Search Results table shows processes that match the default saved 
search, Last 24 hours. 

• The table might be blank if nothing was submitted. 

• If submission notes were entered when submitting the process, you can use 
the Submission Notes column to help identify the process. 

2. If you don't see the process, click the Refresh icon or use the Search section. 

3. Do any of these tasks to check on the progress of the process: 

• For more details about the status, click the status link. For example, if a 

process is in the Ready status, you can click the Ready link in 

the Status column to see where the process is in the submission queue. 

• Check the Start Time column to see if the process has started running 

yet. 

• In the Search Results table, find the This Job's Items Processed / 

Errors / Total column. For some scheduled processes, this column 

shows what's getting processed and how things are going.  

• Click the View Log button, especially if your process has a blank This 

Job's Items Processed / Errors / Total column. The type of information 

in the log varies, depending on the process. You can open the log from 

here only for if the process is currently running. When the process is 

done, you might want to also take a look at the final log, if any, from the 

Details section. 

 
To view output from scheduled process 
 

1. Click Navigator > Tools > Scheduled Process. 

2. Find your scheduled process and, if you need to, refresh the search results to see 
the latest status. 

3. Select the scheduled process. 

4. Go to the Output subsection in the Details section. 

5. Click the link in the Output Name column to view or download the output, which you 
can then print. 
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6. To view or export the output in a different format: 

a. Click the Republish button. 
b. Click the Actions icon. 
c. Select Export, and then select a format. 
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2 SUPPLIER MAINTENANCE 

Supplier Landing Page/ Overview Page 

 

The overview page provides the Supplier Administrator with the supplier information needed 
to carry out tasks ranging from routine maintenance, to event driven administrative 
responsibilities. In addition, the overview page contains reports that highlight supplier issues 
requiring attention and provides easy access to maintain and update supplier records. From 
the overview page, the Supplier Administrator can quickly get in touch with a contact for a 
supplier reported to require communication by accessing the Actions menu. 

 

No. Page Navigation 

1.  Suppliers   Procurement > Suppliers  

Table 2: Navigation 

 

 

Figure 11: Supplier Landing Page 

 

The Suppliers Work Area Overview page contains the following reports: 

 

Suppliers Spend Authorization Request: Identifies suppliers spend authorization request 
that are pending approval or rejected.  
 
Supplier Business Classifications: Lists suppliers for whom one or more business 
classification certificates are about to expire or have expired. This report helps the Supplier 
Administrator keep supplier records that are in risk of losing their diversity status (which could 
impact the supplier relationship) current and accurate. 
 
Suppliers with Incomplete Setup: List suppliers created in the past 30, 60 or 90 days with 
no active addresses, no contacts or tax identifiers. An active address is required to procure 
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from a supplier. The Supplier Administrator should act to complete required supplier setup for 
this list so that each supplier is transaction ready.  
 
Supplier Profile Change Request Pending Approval: This report lists all contact change 
requests pending approval for both active and inactive suppliers. The report helps the Supplier 
Administrator identify the approval queue for contact change requests requiring review by the 
buying organization. This report is displayed only if Oracle Fusion Supplier Portal is 
implemented 

 

2.1 Supplier Creation and Update 

 

Creating Supplier 

No. Steps 

1.  Navigate to Procurement > Supplier 

2.  Click the Task Panel Tab > Create Supplier. If you do not see Create Supplier task, 
click Manage Supplier, and click Create. 

3.  Enter Supplier name, Business Relationship (Prospective / Spend Authorize) and 
Tax Organization Type 

4.  You can also provide tax country, tax registration number, taxpayer ID (not 
compulsory) or D-U-N-S number. 

5.  Click Create  

 

 

Notes:  

− If there are any matching names, you may get this as a suggestion, that there is a 

possibility that you are trying to create a duplicate record.  

− Supplier numbering will be auto populated by the system if creating supplier using this 

screen. 

**Supplier number that can be entered by the user only will available when using the FBDI 

template. 
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Figure 12: Creating Supplier 

 

Once Supplier record is created, you can edit, manage, or update the supplier record. 

 

So, there are 4 tabs to that you can filled to complete supplier details for use in transaction, 
Profile, Addresses, Sites and Contacts Tab. 
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Profile Tab 

 

Figure 13: Supplier Profile Tab 

 

On the Profile tab, you can review the supplier details that you have provided earlier upon 
creating the supplier and fill more profile information regarding to the supplier. 

 

On the lower section of this page, you can also fill more profile details for that supplier such 
as Organization, Business Classification, Product & Services, Transaction Tax, Income Tax 
and Payment Details. 

Required field to enter on this section is Payment Details. 

 

Figure 14: Entering Payment Details 
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To enter Payment Details: 

1. From Profile Details Section under Supplier Profile Tab, Navigate to Payment 

2. Click On Payment Methods, Choose the Default Method of Payment and Click on 

to default.  

3. Click On Bank Accounts, Enter Supplier Bank Account Details. 

4. Once all information needed are filled click on Save and Close. 

 

Address Tab 

 

Figure 15: Creating Address 

 

You can create Supplier Address in the Addresses tab, Tick on Remit to and Ordering on the 
Address Purpose since this address will be choose as a pay to site. You can also capture the 
phone number, fax number, email ID. And if this address is going to become inactive at any 
stage, you can provide an inactive date. 

On the lower section of this page, you can also fill more profile details for that supplier Address 
such as Sites, Transaction Tax, Contacts and Payment. 

Once all information needed are filled click on Save and Close. 
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Sites Tab 

 

Figure 16: Creating Site  

 

On the Site Tab, you can assign business units (procurement BU) to a site from this tab. The 
business unit you attach is going to be the procurement business unit and treated as 
pay/primary pay site by enabling pay/ primary pay flag. 

Then you can provide the contact information 

Once all information needed are filled click on Save and Close. 

 

Contacts Tab 

 

Figure 17: Creating Contact 

 

On the contact tabs you can define the contacts. Contacts can also be defined either at the 
supplier profile level or at the site level. Contacts setup at the supplier profile level represents 
the supplier and all the sites. Sites-level contacts represent only that address. You can use 
the contacts to capture name, job title, email IDs. 

Once done click on Save and Close. 
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2.2 Supplier import using File-based Data Import 

Supplier Import processes are programs that you can use to import new supplier records 
from external systems and to update and delete existing supplier records by bulk. This 
function is mainly used for Supplier Data Migration. 

These programs are used to import supplier information: 

• Import Suppliers 

• Import Supplier Addresses 

• Import Supplier Sites (includes third-party payment relationships) 

• Import Supplier Site Assignments 

• Import Supplier Contacts (includes user accounts and contact addresses import) 

• Import Supplier Business Classifications 

• Import Supplier Products and Services Categories 

• Import Supplier Attachments 

• Purge Supplier Interface Records 

The Supplier Import process is run by either the Supplier Administrator or the Supplier 
Manager. 

You can load data to interface tables using predefined templates and the Load Interface File 
for Import scheduled process. Both are part of the External Data Integration Services for the 
Oracle Cloud feature. 

Obtain FBDI templates from the File-Based Data Import for Oracle Procurement Cloud guide 
from the links found in the File-Based Data Imports section. 

The process for supplier import is as follows: 

1. Data must first be inserted into the existing Open Interface Tables: 

• POZ_SUPPLIERS_INT 

• POZ_SUP_ADDRESSES_INT 

• POZ_SUPPLIER_SITES_INT 

• POZ_SITE_ASSIGNMENTS_INT 

• POZ_SUP_CONTACTS_INT 

• POZ_SUP_CONTACT_ADDRESSES_INT 

• POZ_SUP_BUS_CLASS_INT 

• POZ_SUP_PROD_SERV_INT 

• POZ_SUP_ATTACHMENTS_INT 

• POZ_SUP_THIRDPARTY_INT 

Note: For more information about tables, see the Tables and Views for Oracle 
Procurement Cloud guide. To obtain the templates to use, see File-Based Data 
Import for Oracle Procurement Cloud. Use the instructions contained in the template 
to complete the template. 

The fields used vary from one type of template to another, but all templates begin 
with these fields: 

• Batch ID - Enter a value in the Batch ID field to group certain entries together. 
When you perform the upload, you can choose to process only the entries 
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with a certain batch ID value. This lets you maintain a single upload file and 
selectively choose subgroups of entries to be processed from it, without 
having to process the entire file. 

For example, for a supplier address upload file, you might use a batch ID 
value for the state. When you process the upload file, you can choose to 
process only the records for the state of California. 

• Import Action - Use Create to add a new entity, such as a new site 
assignment or a new address. Use Update to modify an existing entity. 

 

2. Once the data is inserted, the following concurrent processes must be run to import the 
supplier profile data one by one in Oracle Fusion Suppliers: 

• Import Suppliers 

• Import Supplier Addresses 

• Import Supplier Sites 

• Import Supplier Site Assignments 

• Import Supplier Contacts 

• Import Supplier Business Classifications 

• Import Supplier Products and Services Categories 

• Import Supplier Attachments 

 

These import processes are executed by the Enterprise Scheduler Service (ESS), 
which manages all concurrent processes. You can monitor the status of each process 
and provide access to output reports. 

 

Supplier import processes contain the following parameters: 

• Import Options: Options include All, New, and Rejected. Import Options are 
used to determine if the import process should attempt to import new, rejected, 
or all rows from the respective open interface tables. 

• Report Exceptions Only: Values are Yes or No. Used to determine if the 
Import Process Reports prints success and rejected information, or just the 
rejected information. 

 

3. When the processes are complete, a pdf report is generated detailing the status of the 
records that were imported. If a record couldn't be imported, then the status is set to Rejected. 
The reason for the rejection is provided. 

 

Upload line level errors are applicable only to a line and don't affect the loader's capability to 
read and process the remainder of the lines in the upload file. Upload line errors can be caused 
by an invalid UOM for a line, or an incorrect data type specified for a line attribute. Line level 
errors are displayed in the line errors region or parsing errors region on the upload errors 
page. Line level errors can be exported to a spreadsheet for review. 

 

Upload file-level errors are detected at the start of processing. The loader is halted and no file 
lines are processed. Upload file-level errors can be caused by invalid XML or cXML files, 
mandatory sections missing from a TXT file, or sections out of order in a TXT file. The upload 
errors page displays the file level error. The line or parsing errors region isn't displayed. 
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The error threshold parameter sets the maximum number of errors allowed on upload lines 
before termination of upload file processing. You can export the items table to perform an error 
analysis. 

Note: 

• The supplier import processes are used to create new entities, and to update or delete 

existing supplier profile data. Creation can be done only with attachments. Deletion 

can be done only with contact addresses, business classifications, and products and 

service categories. 

• Supplier import supports supplier numbering of characters that aren't numeric to allow 

supplier records from legacy systems to retain their unique identifier. 

• Update supports updating the functional key attributes. The columns ending with 

_NEW are specifically earmarked for updates. Use this only if the underlying functional 

key attributes must be updated. To update functional keys, the new value should be 

provided in the _NEW column. 

Consider the following when using supplier import: 

Import Suppliers 

Both Prospective and Spend Authorized suppliers can be imported. Sites and site 
assignments can't be imported for prospective suppliers. 

The Business Relationship of the supplier can't be updated through import. 

 

Import Supplier Sites and Third-Party Payment Relationships 

Supplier Sites are imported for a specific procurement BU, which is specified on the site import 
record. Additionally, an existing supplier address reference must be defined as part of the site 
import record. 

After a site is created and associated with an address, the association can't be changed. For 
this reason, including a value for Address Name when updating an existing supplier site 
triggers an error. The Address Name field maps to PARTY_SITE_NAME, which is the field 
named in the error. 

Use the Supplier Sites Import process to load third-party payment relationships from an 
external system. Before you import supplier site third-party payment relationship data, review 
the recommendations in the supplier site import template, Instructions and CSV Generation 
worksheet. 

There are two separate worksheets available for importing supplier sites and third-party 
payment relationships on the supplier site import template. 

 

Import Site Assignments 

Site assignments are created for client BUs that are serviced by the procurement BU to which 
the site belongs. Assigning the client BU to the site enables the client BU to use the site for 
ordering and invoicing. 
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Import Supplier Contacts, Contact Addresses, and User Accounts 

You can provide addresses associated with a contact for all sites using that address. 

Note: Two separate worksheets are available for contacts and contact addresses on the 
import upload template for supplier contacts. 

The import process checks for duplicate contacts. Provide distinguishing email addresses for 
imported supplier contacts with the same last name as existing supplier contacts. 

Use the User Account Action column to specify the action to create or update a user account. 
Create a user account by using the default roles for the Supplier Portal work area, the Sourcing 
work area, or specifying individual roles. Update a user account by adding or removing specific 
roles or inactivating the user account. Use the Role 1 to Role 10 columns to specify specific 
roles based on the user account action. 

Here are things you can do after you run the supplier contact import process: 

If you need to find out the user accounts that are created or updated successfully, you can 
create a report for that. Go to the Reports and Analytics work area, use attributes in Supplier 
- Supplier Real Time subject area to report on user account details. 

When a user account action is specified for any imported supplier contact, the Send Pending 
LDAP Requests process is launched automatically to complete the user account action. If the 
user accounts aren't created or updated successfully, you can manually run the process using 
these steps: 

1. From the Tools work area, click Scheduled Processes. 
2. Click Schedule New Processes and search for Send Pending LDAP Requests. 
3. For Parameters, choose User Type as Party and Batch Size as A, and then 

click Submit. 

 

Import Business Classifications 

New certifying agencies can be created and associated with relevant classifications through 
import. However, the Certifying Agency attribute option 'Other' isn't supported. Consider using 
the Create New Certifying Agency attribute as an alternative. 

Note: 

Legacy data including both inactive and active data can be loaded for all the supplier entities. 

 

Import Supplier Attachments 

You can import attachments for supplier profiles, supplier sites and supplier business 
classifications for existing suppliers. Different types and categories of attachments can be 
imported. 

For File type attachments, you must add the file to a .zip file and upload the .zip to the 
Procurement Suppliers UCM account: /prc/supplier/import. Multiple files can be added to the 
same .zip file and can be organized within folders as needed. The template is designed to 
accept the path along with the file name. This tells the application in which folder of the .zip 
file the file is located. The Recommendations for Loading Supplier Attachments Data section 
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in the Instructions and CSV Generation tab contains more information on importing 
attachments. 

You can import attachments for: 

• Supplier profile 

• Supplier sites 

• Supplier business classifications 

 

Supplier Bank Account Import Data  

Use the Import Supplier Bank Accounts process to import supplier bank accounts and 
associated data into Oracle Payments. You can download a spreadsheet template to enter 
your supplier bank account data. The template contains an instruction sheet to guide you 
through the process of entering your data. The template also provides field-level bubble help. 

Users can run the Import Supplier Bank Accounts process in the Scheduled Processes area. 

Before you can import supplier bank accounts and associated data, you must create suppliers. 

If the suppliers bank account is used for international payments, you must also create the 
following entities: 

• Banks 

• Bank Branches 

To access the SupplierBankAccountImportTemplate.xlsm spreadsheet template, complete 
these steps: 

1. Navigate to the File-Based Data Import for Oracle Financials Cloud guide. 

2. In the Table of Contents, click the File-Based Data Imports link. 
3. Click the Supplier Bank Account Import link. 

4. In the File Links section, click the link to the Excel template. 

Follow these guidelines when preparing your data in the worksheet: 

1. Enter the required information for each column. Refer to the tool tips on each column 
header for detailed instructions. 

2. Don't change the order of the columns in the template. 

3. You can hide or skip the columns you don't use, but don't delete them. 

The Supplier Bank Account Import spreadsheet template contains an Instruction tab, plus 
additional tabs that represent the interface tables where the data is loaded. 

Table 2 contains the names of the tabs in the Supplier Bank Account Import spreadsheet 
template and a description of their contents and Table 3 shows the Flow of data when you 
import supplier bank accounts into Payments. 

 

 

 



Olivestouch Technologies Sdn Bhd 
User Manual 

Payable Module v1.0 

 

Confidential  Page 27 of 112 

 

Spreadsheet Tab Description 

Instructions and CSV Generation Contains instructions and information about: 

• The format of the template 

• The button that you click to generate the CSV 
file 

Additional information includes the following: 

• Preparing and loading data 

• Submitting the Import Supplier Bank 
Accounts process 

• Correcting import errors 

IBY_TEMP_EXT_PAYEES Enter information about the supplier payees. 

IBY_TEMP_EXT_BANK_ACCTS Enter information about the supplier bank accounts. 

IBY_TEMP_PMT_INSTR_USES Enter information about the supplier bank account 
assignments. 

Table 2: Tabs in the Supplier Bank Account Import spreadsheet template 

 

Sequence Action Result 

1. From the guide titled File-Based Data 
Import for Oracle Financials Cloud, 
download the spreadsheet template 
named SupplierBankAccountImportTe
mplate.xlsm. It is in the File-Based Data 
Imports chapter, Supplier Bank Account 
Import section. 

The File-Based Data Import 
spreadsheet is downloaded. 

2. Enter data in the spreadsheet template. 

Follow the instructions on the Instructions 
and CSV Generation tab under the 
section titled Preparing the Table Data. 

Follow the instructions on the 
Instructions and CSV 
Generation tab under the 
section titled Preparing the 
Table Data. 

3. Click Generate CSV File. 

Follow the instructions on the Instructions 
and CSV Generation tab under the 
section titled Loading the Data in the 
Instructions and CSV Generation tab. 

A CSV file is generated that's 
compressed into a ZIP file. 

4. To upload the ZIP file: The ZIP file is uploaded. Data 
is loaded into Payment 
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1. Navigate: Tools > File Import 
and Export. 

2. In the File Import and Export 
page, click the "+" (Upload) icon. 
The Upload File dialog box 
appears. 

3. In the File field, browse for and 
select your ZIP file. 

4. From the Account choice list, 
select fin/payables/import. 

5. Click Save and Close. 

Interface Tables successfully 
or with errors. 

5. To submit the Load Interface File for 
Import process: 

1. Navigate: Tools > Scheduled 
Processes. 

2. Click Schedule New Process. 

The Schedule New Process dialog 
box appears. 

3. From the Name choice list, 
select Load Interface File for 
Import. 

4. Click OK. The Process Details 
dialog box appears. 

5. From the Import Process choice 
list, select Import Supplier Bank 
Accounts. 

6. From the Data File choice list, 
select your ZIP file. You can also 
upload a new file here, skipping 
the fourth process.  

7. Click Submit. 

Data is loaded into Payment 
Interface Tables. 

6. Follow the instructions on the Instructions 
and CSV Generation tab under the 
section titled Importing the Loaded Data 

Load process purges 
Payment Interface Tables. 

7. To submit the Import Supplier Bank 
Accounts Process: 

1. Navigate: Tools > Scheduled 
Processes. 

The Scheduled Processes page 
appears. 

2. Click Schedule New Process. 

The Import Supplier Bank 
Accounts process first 
validates the supplier bank 
accounts and associated data 
and then imports the data 
from the Payments interface 
tables into the following 
Payments tables: 

• IBY_EXT_BANK_ACC
OUNTS 
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The Schedule New Process dialog 
box appears. 

3. From the Name choice list, 
select Import Supplier Bank 
Accounts. 

4. Click OK. 

The Process Details dialog box 
appears. 

5. From the Feeder Batch Identifier 
choice list, select the batch 
identifier that you indicated in the 
File-Based Data Import 
spreadsheet. 

6. Click Submit. 

• IBY_EXTERNAL_PAY
EES_ALL 

• IBY_PMT_INSTR_US
ES_ALL 

After you submit the Import 
Supplier Bank Accounts 
process, the following data 
appears in Payments: 

• Supplier bank 
accounts 

• Payment preferences: 

o payment 
delivery 

o payment 
specifications 

o separate 
remittance 
advice delivery 
method 

• Relationship of 
supplier with supplier 
bank account 

The log output of the Import 
Supplier Bank Accounts 
process reports the number of 
successful and rejected 
records. 

8. To correct import errors: 

1. Identify the rejected records 
based on details provided in the 
log file. 

2. Create a new spreadsheet that 
contains only rejected records that 
are copied from the old 
spreadsheet. 

3. For the Import Batch Identifier 
column, enter a different Feeder 
Batch ID. 

4. Make necessary corrections to the 
data. 

5. Load the data using a new 
spreadsheet. 

6. Generate the CSV File, upload the 
ZIP file, and continue. 

Failed records remain in the 
Payments interface table and 
aren't purged automatically. 
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7. Failed records remain in the 
Payments interface table and 
aren't purged automatically. 

9. Import supplier bank account data at one 
of the following levels if you have their 
associated identifiers: 

• Supplier level requires the 
Supplier Number. 

• Supplier site level requires the 
Supplier Site Code. 

If only the Supplier Number is 
provided, the supplier’s bank 
account is created at the 
supplier level. 

If the Supplier Number and 
the Supplier Site Code are 
provided, the supplier bank 
account is created at the 
supplier site level. 

10. Set the Primary indicator in the SQL 
loader file for only one bank account per 
supplier per level. 

If the Primary indicator is set 
for multiple bank accounts, 
then Payments accepts only 
the first bank account with the 
indicator set to be the primary 
account at that level. 

If the Primary indicator isn't 
set for any bank account, 
Payments accepts the first 
bank account as the primary. 

11. Manage intermediary account details and 
create factor accounts manually using the 
Manage Suppliers page. 

The Import Supplier Bank 
Accounts process doesn't 
allow you to import the 
following data: 

1. Intermediary accounts 

2. Factor accounts 

Table 3:  Flow of data when you import supplier bank accounts into Payments 

 

Supplier Tax Details Import 

You can import supplier's profile level tax registration country and the tax registration number 
using supplier import template. You can add these values while creating or updating suppliers. 
All the other supplier's tax registration related attributes can be imported using the Tax 
Implementation Workbook. For more information on the Tax Implementation Workbook, see 
the related topics below. 

You can use the Tax Implementation Workbook to update the values of tax registration country 
and tax registration number also, but it's recommended to do it through the supplier import for 
these reasons: 

• Using supplier import will validate the supplier for duplicate tax registration number and 
therefore prevent duplicate supplier creation. 
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• Using the supplier import will create a party tax profile for the supplier, which otherwise 
must be done using the Tax Implementation Workbook through a separate worksheet 
that's hidden by default. 

If you haven't already done the Tax setup, you must first complete the configuration using the 
Tax Configuration Workbook. For more information on the Tax Configuration Workbook, see 
the related topics. 

You will have to use the Tax Implementation Workbook to import supplier address level tax 
registration details. Supplier addresses are uniquely identified using the party site ID, which 
can be used when importing address tax registration information. 

 

Import Regional Information 

You can import region specific information for suppliers and supplier sites. 

1. To import supplier or supplier site regional information, in the 
GLOBAL_ATTRIBUTE_CATEGORY column provides the value for Regional 
Information lookup. In subsequent columns, for the GLOBAL_ATTRIBUTE1 - 20, 
GLOBAL_ATTRIBUTE_DATE1-10, GLOBAL_ATTRIBUTE_TIMESTAMP1-10, and 
GLOBAL_ATTRIBUTE_NUMBER1-10, provide the values of attributes dependent on 
the regional information attribute. 

To successfully import the record, for lookup type attributes, you must provide the 
necessary codes and not the display values. 

2. To get the necessary codes, in the Setup and Maintenance work area, go to 
the Manage Descriptive Flexfields task and search for the flexfield code 
JE_POZ_SUPPLIERS. Select to edit the DFF entity to get all the relevant details. 

For the regional information lookup, access the page Manage Contexts from the edit 
descriptive flexfield page for the descriptive flexfield entity JE_POZ_SUPPLIERS. For 
the dependent attribute codes, access the context sensitive segment for the respective 
context and find the value set that is used. From the value set, you can get the codes 
for these attribute lookup values. 

3. Do the import. 

 

Notes: You may also just import supplier to generate the supplier number manually then 
continue the supplier creation through the screen 
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3 INVOICE PROCESSING (DIRECT INVOICE) 

 

Invoice Work Area/ Landing Page 

 

Figure 18: Invoice Work Area 

 

Navigate to:  Payables > Invoices 

Use the Invoices Work Area to perform various task when processing invoices. You can focus 
on invoices that require your attention through the infolets displayed on the Invoices Work 
Area. 

The following infolets are described: 

• Recent: The number of invoices that have been updated and recently added. The red slice 
shows the portion of invoices that still need to be validated. Clicking on the number displays 
those invoices in the subsequent table. The blue slice indicates invoices that are validated or 
cancelled, which means they are complete. 

• Holds: Displays the number of invoices put on hold and categorized by the type of holds that 
have been applied. The invoice data needs to be corrected to resolve the validation holds. 
Holds are displayed by the type and require review and release, usually by a manager. 
Clicking the linked type displays those invoices in the subsequent table. 
• Prepaid: Prepayments categorize available prepayment that can be applied to invoices. 
Categorizing them is based on aging buckets defined by you, the number of available 
payments is displayed in each aging bucket. Clicking on the number in the bucket displays the 
invoices in the subsequent table. 
• Due: Indicates by currency the total amount due for payment. Viewing the overall status of 
the invoices enables you to take the appropriate action to process the invoices. 

You can manually enter supplier invoices by using the Invoices work area, which is basically 
used to enter any invoice directly into the Payables system. For example, you can use the 
Invoices work area to create an invoice that needs immediate action, such as payment. You 
can also match the invoice to purchase orders while entering these invoices from the Invoices 
work area. 
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3.1 Prepayment Invoice Creation and Application 

A prepayment is a type of invoice you enter to make an advance payment to a supplier. 

You can later apply the prepayment to one or more invoices you receive from supplier to offset 
the amount paid to them. 

 

Create Prepayment Invoice 

1. Navigate to:  Payables > Invoices > Task > Create Invoices 

Or Payables > Invoices>Create (Actions Toolbar) 

 

Figure 19: Creating Prepayment Invoice 

 

2. Enter the details below: 

Fields Description 

Business unit Choose the business unit for which you want to 
create the prepayment 

Type Select Prepayment 

Supplier Enter the supplier’s name to whom you want to 
make the advance payment. Supplier site and Legal 
Entity will be auto filled when supplier name is 
entered. 

Allow Prepayment Application Tick on the Allow Prepayment Application to allow 
the application with Standard Invoice in future. 

Apply After State the start date when does this prepayment will 
be available to applied with the Standard Invoice. 

Date Enter the date of the invoice. The date will always 
default to System Date 
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Invoice Number Enter the Prepayment Number to represent this 
advance invoice. 

Invoice Amount Enter the amount that you are giving as advance 
payment. 

Payment term Immediate (default), Select other payment terms 
accordingly. 

Terms date Same as date of invoice. Revised the date if 
required 

Table 4: Fields for Creating Prepayment Invoice 

 

Then Go to the Line tab enter the below information. 

 

Fields Description 

Amount Enter the line amount. 

Distribution combination Auto filled. System retrieves the prepayment 
invoice distribution account automatically based on 
the account that you have either provided at the 
supplier level or from the common payable and 
procurement options. Field Prepayment. 

Description Item description. You may provide any details on 
the Invoice lines.  

Tax Classification If the supplier has been assigned with default Tax 
value, this field will have default tax value. Kindly to 
amend the field if the prepayment is not applicable 
for the Tax.  

Table 5: Fields for Line Tab in Creating Invoice 

 

3. Click Save  

4. From Invoice Action>Calculate Tax to verify whether hurdle level and the line level 

amount matches or not. Only did this action if there is any Tax Classification define. 

5. Then from Invoice Action> Validate, the system will change the status to unpaid. 

6. Only the paid prepayment invoices will be eligible for application. To pay the invoice in 

Full You may proceed the payment in Payment work area or directly Pay in Full. 

7. To proceed with Pay in Full function from Invoice Action> Pay in Full 

8. A window will prompt to enter Payment Details. Mandatory field to Enter are Bank 

Account and Payment Process Profile. Click Submit  
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Figure 20: Payment Window 

 

To apply prepayment on a standard invoice, start by creating a standard invoice or use the 
standard invoice that have already been created. 

 

On the Create Invoice tab, 

1. Enter the details below: 

Fields Description 

Business unit Same business unit use in Prepayment Invoice 

Type Select Standard 

Supplier Enter the same supplier from the Prepayment 
invoice 

Date Enter the date of the invoice. The date will always 
default to System Date 

Invoice Number Enter the supplier Invoice Number to represent this 
invoice. 

Invoice Amount Enter the amount that you are giving as advance 
payment. 

Payment term Immediate (default), Select other payment terms 
accordingly. 

Terms date Same as date of invoice. Revised the date if 
required 

Table 6: Fields for Creating Standard invoice For Prepayment Application 

Enter the information in the Line Tab as indicated in Table 5. 

 

2. Click Save  
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3. From Invoice Action>Calculate Tax  

4. Then from Invoice Action> Validate. 

You can also apply your prepayment invoice without validating the standard invoice. 

5. From Invoice Action>Apply or Unapply Prepayment 

 

 

Figure 19: Application of Prepayment Window 

 

6. Select the row in Available section, Click on Apply. 

The selected row and amount will appear in Applied Section. 

7. Click Done 

8. To unapply the prepayment, go into the same page. Select the row in Applied Section 

9. Click Unapply 

10. Click Done. 

When you apply your prepayment invoice, you will notice that a prepayment application line 
gets added to the Line section of your invoice. And the same is visible in the Distribution 
section 

Also, whenever the prepayment invoices are applied to a standard invoice, the status of the 
standard invoice changes to needs revalidation. And you must validate this invoice again. 
Once the invoice has been validated, choose Save and Close to close the Invoice page.  
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3.2 Standard Invoices Creation (Direct Invoice) 

 

Creating manual invoices/credit & debit memo 

1. Navigate to:  Payables > Invoices > Task > Invoices >Create Invoices 

2. Enter the details below: 

Fields  Description 

Business unit Choose the business unit for which you want to create the 
prepayment 

Type Select  

Standard: For invoices issued by a supplier to the buyer, 
representing the amount due for the products or services the 
supplier has provided to the buyer. Can be either matched to a 
purchase order or not matched. 

Credit Memo: For invoice raised by the supplier to the buyer. It 
reduces the supplier balance and reduces the liability. 

Debit Memo: Invoice raised by the customer to supplier. The 
functionality of Debit Memo is same as Credit Memo. Both are to 
reduce the liability. The purpose of Debit Memos is to record a 
credit for a supplier who does not send you a credit memo. 

Supplier Enter the supplier’s name to whom you want to make the 
payment 

Invoice Date Enter the date of the payment 

Invoice Number Enter a unique number to represent this invoice. 

Invoice Amount Enter the amount that you are giving as payment. 

Positive amount for Standard Invoice. 

Negative amount for Credit Memo & Debit Memo. 

Payment term Select the chosen payment term from the dropdown list. 

 

Terms date Same as invoice date. 

Table 7: Fields for Creating invoice  

 

3. Manually enter below information: 

Fields Description 

Amount Enter the line amount. 
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Distribution Set Enter the distribution set (predefined setup for expense 
entry) or 

Distribution combination Enter the distribution combination 

Description Item description 

Tax Classification Code Not required to fill 

Withholding Tax Group 
Enter the WHT code charged to the invoice line if there is 
a WHT involved on the supplier invoice.  

Table 8: Fields for Creating invoice, Line Tab 

4. Click Save. 

5. Click on Invoice actions > Validate the invoice. 

6. Click on Invoice actions > Approval > Initiate. 

Notes: Only invoices from ISP will be route for approval to Finance user ID. Other than 
that, all invoices will be auto approved. 

 

3.3 Standard Invoices Creation (Matching by PO) 

1. Navigate to:  Payables > Invoices > Task > Invoices >Create Invoices 

2. Enter the details below: 

Fields  Description 

Identifying PO Search and choose the PO number to be matched with 
invoice 

Business unit Info will be defaulted based on PO 

Type Type defaulted to Invoice 

Supplier Info will be defaulted based on PO 

Invoice Date Enter the date of the Invoice 

Invoice Number Enter a unique number to represent this invoice. 

Invoice Amount Enter the amount that you are giving as invoice amount 
inclusive SST. 

Tax Classification Code Not required to fill in. 

Withholding Tax Group 
Enter the WHT code charged to the invoice line if there is 
a WHT involved on the supplier invoice.  

Payment term Select the chosen payment term from the dropdown list. 
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Terms date Same as invoice date. 

Table 7: Fields for Creating invoice  

 

4. Then Go to the Line tab you will have the option to matched invoiced line, match to 

receipt charge, correct matched invoices and correct unmatched invoice by providing 

PO number. Click on the Go icon . 

5. System will appear the available PO with GRN number which available for matching. 

6. If the PO have yet to received/created a GRN, system won’t show any result for 

matching process. 

 

 

7. After matched, the Invoice line will be populated based on matched data from PO. 

Fields Description 

Amount Info will be defaulted based on PO Lines 

Distribution combination Info will be defaulted based on PO Lines 

Description Info will be defaulted based on PO Lines 

Tax Classification Not required to fill in. 

Table 8: Fields for Creating invoice, Line Tab 
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7. Click Save. 

8. Click on Invoice actions > Validate the invoice. 

9. Click on Invoice actions > Approval > Initiate. 

 

3.4 Invoice Creation by Spreadsheet  

This process can be used to create invoices in bulk. The information is keyed in the Oracle 
spreadsheet and by running the import process, the data will be transferred to Oracle Payables 
for invoice creation in bulk. 

 

1. Download Oracle Spreadsheet from the system. 

 

 

2. The excel spreadsheet will be downloaded into your device. 

3. Kindly open the file and login by using your same access in Oracle. 

4. The file is link to your System’s ID. Therefore, you must maintain the spreadsheet 

separately between Test and Production instance. 

Notes: Your device must have ADFdi (Deskstop Integrator Installer) and link to your excel 
application. Refer to User Manual (How to setup Spreadsheet using ADFDI). 

 

 

 

5. After open the Spreadsheet, click ok Yes button to login. 
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6. You should see the excel overview as below if your excel were connected to the 

System after login successfully. 

 

 

7. Fill in the Information of your invoice accordingly. All field that exists in the System will 

be available in this Spreadsheet.  

Notes: The * mark is indicated that the field is mandatory and must not leave it as blank. 
[..] indicates that the field is connected to the System for data searching and query for 
selection instead of manual entry. 

 

Fields Description 

Changed This column is to indicate the changes applied on the specific row 

Row Status  Column to highlight on the import status. (not for user to key in) 

*Invoice Header Identifier 

This is the Invoice ID in the spreadsheet to indicate unique ID for 
each of the invoice. Use the repeated Invoice Identifier for Invoice 
with multiple lines. 

*Business Unit Business Unit Name for the invoice to be created 



Olivestouch Technologies Sdn Bhd 
User Manual 

Payable Module v1.0 

 

Confidential  Page 42 of 112 

 

Import Set You may use this field to define your invoice set   

*Invoice Number Invoice number provided by the supplier 

*Invoice Currency Invoice currency to be entered in the System 

*Invoice Amount Total invoices amount inclusive VAT 

*Invoice Date Date of the invoice 

**Supplier[..] Supplier Name for the invoice 

**Supplier Number Supplier Number of the invoice 

*Supplier Site[..] Supplier site/address of the invoice 

Payment Currency 
Payment currency for the invoice (Invoice to be paid in which 
currency) 

Invoice Type 
Invoice Type to indicates whether this is Invoice/Credit Memo/Debit 
Memo 

Description Invoice header description 

Payment Terms 

Payment terms for the invoice (if this info is blank, system will pick up 
based on the payment terms default value from Supplier Profile or 
Invoice Option) 

Terms Date Terms Date 

Accounting Date Invoice Accounting date 

Invoice Includes 
Prepayment 

Use this field if the invoice were created to be applied with 
Prepayment invoice 

Prepayment Number[..] 
Use this field and enter the Prepayment number if the invoice were 
created to be applied with Prepayment invoice 

Prepayment Line 
Use this field and enter the Prepayment line if the invoice were 
created to be applied with Prepayment invoice 

Prepayment Application 
Amount 

Use this field and enter the Prepayment amount if the invoice were 
created to be applied with Prepayment invoice 

Prepayment Accounting 
Date 

Use this field and enter the Prepayment accounting date if the invoice 
were created to be applied with Prepayment invoice 

Payment Method 

Payment method for the invoice (if this info is blank, system will pick 
up based on default value from Supplier Profile or set is as Check) 
The value should be the Payment Method Code (refer Workbook 
Configuration) 

Conversion Rate Type 
Use this field and enter the Conversion Rate Type if the invoice is in 
foreign currency 

Conversion Date 
Use this field and enter the Conversion Date if the invoice is in foreign 
currency 
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Conversion Rate 
Use this field and enter the Conversion Rate if the invoice is in foreign 
currency 

Line Enter the Invoice Line number (e.g. 1, 2, 3,…) 

*Type Enter the Line Type as Item 

*Amount 
Enter the amount of the invoice line (amount should be exclusive 
VAT) 

Description Enter the Invoice Line Description. 

Distribution 
Combination[..] Enter the distribution code combination for the Invoice 

Distribution Set[..] 

Select the Distribution Set (if you maintain the distribution code 
combination by Distribution Set setup). Please blank the field 
Distribution Combination if you are using Distribution Set 

Accounting Date Enter the Invoice Line Accounting date 

Tax Classification Code Not required to fill 

Withholding Tax Group 
Enter the WHT code charged to the invoice line if there is a WHT 
involved on the supplier invoice.  

Multiperiod Accounting 
Start Date 

Enter the Multiperiod Accounting Start Date if your invoice is a 
deferred expense. The start date is to indicate when will the actual 
expense will be recognized. 

Multiperiod Accounting 
End Date 

Enter the Multiperiod Accounting End Date if your invoice is a 
deferred expense. 

Track as Asset Indicate as Yes if your invoice is an Asset Invoice. 

Book Enter the Book name for the Asset Invoice 

Multiperiod Accounting 
Accrual Account[..] 

Enter the Multiperiod Accounting Accrual Account for the deferred 
expense. (Prepayment Account) 

Key 
This column is utilized by system as a flag for data import. (user must 
not change anything on this column) 

 

8. After filled in the information in the spreadsheet. User may save the file then click on 

the Save and Submit Invoice Import to import the invoice in the System. 

 

 

9. All rows that has been imported will have indicator flag as shown below: 
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10. Meanwhile, the Scheduled Processes you may see there will be a program running for 

Import Payables. 

11. The program should be ended successfully and generate the execution report Import 

Payables Invoices Report.  

 

 

12. The report will show you the summary details how many invoices were created 

successfully. 

 

 

13. The report will also show the error or unsuccessfull invoice with an error message. 

14. The fixing can be done from the Spreadsheet and perform the Save and Submit Invoice 

Import again. 

 



Olivestouch Technologies Sdn Bhd 
User Manual 

Payable Module v1.0 

 

Confidential  Page 45 of 112 

 

 

15. The created invoice will appear in the System with source spreadsheet. The validation 

and approval process can then proceed directly from the system. 

 

3.5 Manage Invoice (Additional Functions)  

There are several ways to manage invoices. 

From Invoice Landing Page 

a. 

1. Navigate to:  Task > Manage Invoices 

2. Enter at least one of the known values for indicated Field to search for the Invoice, eg. 

Supplier/ Party Field or Invoice Number 

3. Click Search 

Period Window will prompt if Supplier/ Party, Supplier Site or Supplier Name is 

entered. 

4. Choose the Period for the Supplier Invoices, from as short 3 days up to 180+ days 

period. 

The list of invoices matches the search will be disclosed and you can manage invoices 
accordingly. 

b. 

1. Navigate to:  Search> Enter Invoice Number or Supplier/ Party-at least one is 

required 

2. Click Search 

c. 

1. Click on Recent Infolet, the content area will show the list of recent infolet in 7days. 

2. Click on the invoices that you would like to manage. 

3. From here you can Validate, Cancel or Post the Invoice to Ledger. 

 

Extract to excel function 

You can extract the list of Invoices from Recent Invoices or the list from your Search into 
excel. From the Action Tab. Click on Export to Excel button. 

 

 

 

You can choose what column details to shown on the list and the same column will be export 
to your excel. 

Figure 22: Export to Excel Function 

 

 

  

Export to excel 
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3.6 Invoices with Multiperiod Accounting 

1. Enter the necessary information to create the invoice. For detailed Explanation please 

follow “Standard Invoice” process on how to create the invoice.  

 

2. Populate either Distribution set or Distribution combination to book the period share of 

expense in respective subject and other GL string. Then Click on Multiperiod 

accounting tab. 

 

3. Fill in the start date, End date and Accrual account. 

 

 

4. Click on Invoice actions > Validate the invoice. 

5. Click on Invoice actions > Approval > Initiate. 

6. Run ESS Job “Create Multiperiod Accounting”. Navigator > Tools > Schedule 

Process > Schedule New Process 
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7. Click on “Accounted” under invoice summary section on the Invoice screen. 
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3.7 Invoices Approval Routing Process 

1. Every Invoice in LSE will have a different workflow process and route to a different 
approval group. 

2. In the current process each BU will have the invoice approval process including auto 
approve invoices. 

3. Each of the approval setup is assigned to the Finance user ID 
4. Every invoice requires approval, the key user must initiate the approval after Validate 

the invoice. 

Notes: The invoice will not be available for any amendment after initiate the approval. They 
must withdraw the approval first before edit. The Edit button will be enabled after invoice 
has been withdrawn. After amendment, you must select Resubmit not Initiate. Initiate only 
for first time approval initiator. 

 

5. As initiator, after you initiate or resubmit the approval, you may check the approval 

route at View Approval and Notification History. 

 

 

6. When the key user initiated the approval, system will submit an approval program and 

send a notification to the first approver by email and by system notification 

simultaneously.  
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Email Approval Notification: 

 

 

System Approval Notification: 

 

 

3.7.1 Invoices Approval by Email 

 

A) Approve Invoices 

1. After Approver received an email notification, they can approve by click on the Approve 

button from the email.  

 

 

2. The expected behaviour is it trigger as sending an email like figure below: 
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3. You may add in any comments or more information in your email content and send the 

email. 

4. System will route to the next approver including the comments. 

 

B) Request Info for the Invoices 

1. The approver may request for more information such as document attachment etc. 

2. To do this the approver must click on the Request Info button. 

 

 

3. The expected behaviour is it trigger as sending an email like figure below: 
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4. You may add in any comments or questions for more information in your email content 

and send the email. 

5. System will route and notify the initiator by email and system notification including the 

comments. 

 

 

C) Reject Invoices 

 

1. If the Approver click on the Reject button and send the email, system will send an email 

and system notification to the initiator regarding the invoice approval rejection. 

2. At this stage, the initiator may amend the invoice accordingly and resubmit the 

approval. 

 

3.7.2 Invoices Approval by Notification 

A) Approve Invoices 

1. After Approver received a notification in the system, they can approve by directly click 

on the Approve button from the notification.  

 

 

2. System will automatically route the notification to the next approver. If there is no further 

approver, the invoice will be approved, and system will notify the initiator that the 

invoice has been approved. 

 

B) More Action for the Invoices 

1. The approver may also request for more information by clicking on the the Approval 

sentence. 

2. System will prompt a new window as follows: 
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3. At this stage, click on the Action button, the approver may see a few of functions that 

can be done on the invoice. 

Action Description 

Edit Distribution Use this button if the approver wants to edit the distribution. It is 
advisable to let and inform the key user to edit the distribution since 
the amendment or updates is recorded on the invoice. 

Request Information Use this button to send a questions or comments to the initiator. 

Delegate To delegate the approval action to other user ID  

Reassign To reassign the approval action to other user ID 

Route Task To route the approval action to other user ID (In LSE setup the 
delegate, reassign, route task will have the same impact) 

Add Comments To add comments in the Invoice Approval history 

Add Attachment To add attachment in the Invoice Approval History 

View Approvals To view the approval in full process. 

 

4. When the approver chooses action Request Information, they can route the question 

to which user (only one user) by assigning at the Name field. 

5. The comments or questions can fill in the Comment field. 

6. Next, the approver can also choose the return options as back to me or follow the 

approval flow when the respective user provides or answer the questions. 

7. The respective user will receive notification after the approver click on the Submit 

button. 
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8. This additional action button is only applicable to perform in the system directly. 

9. The email notification will be limited to (Approve, reject & Request Information) actions 

only. 

 

C) Reject Invoices 

1. If the Approver click on the Reject button, system will send an email and system 

notification to the initiator regarding the invoice approval rejection. 

2. At this stage, the initiator may amend the invoice accordingly and resubmit the 

approval. 
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4 ASSETS INVOICES 

4.1 Mass Edition for Assets 

Mass Additions lets you add assets and cost adjustments directly into Oracle Assets from 
invoice information in Payables. The Create Mass Additions for Oracle Assets process sends 
valid invoice line distributions and associated discounts from Payables to an interface table in 
Oracle Assets. Then you review them in Oracle Assets and determine whether to create assets 
from the lines. 

 

Pre-requisites: 

1. Register your Accounts. 

Account Type Must Be Asset 

You must register the clearing accounts you want to use as Asset accounts in the Segment 
Values window. The create mass additions process selects Payables invoice line distributions 
charged to clearing accounts with the type of Asset. 

 

2. Define Valid Clearing Accounts in Oracle Assets 

For each asset category in Oracle Assets for which you want to import invoice line distributions 
from Payables, define valid asset clearing and construction-in-process clearing accounts. 
These accounts must be of type Asset. The create mass additions process only imports lines 
charged to accounts that are already set up in your asset categories. 

 

3. Using Multiple Sets of Books 

Payables must be tied to the same general ledger set of books as the corporate book for which 
you want to create mass additions in Oracle Assets. If you have multiple installations of 
Payables and multiple corporate books in Oracle Assets, ensure that you create mass 
additions for the correct Oracle Assets corporate book. You cannot create mass additions for 
tax books. 

 

4. Post the invoice to General Ledger 

After you run create mass additions, the mass addition line appears with the asset category 
you specified for the item. 

 

4.2 Asset Invoice Creation 

 

Enter Invoices in Payables 

When you enter a new invoice in Payables, if you want the invoice line to be imported to Oracle 
Assets, you must charge the distribution to a clearing account that is already assigned to an 
asset category. The line amount can be either positive or negative. 
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Invoice Description Field 

Any additional information you enter in the Description field in the Invoices Summary window 
in Payables appears in the Description field in the Mass Additions window in Oracle Assets. 

 

Units 

If your invoice is matched with PO that have single or multiple lines, the Create Mass Additions 
process uses the number of units specified by the original purchase order for the mass addition 
line. Mass addition lines created from invoices entered directly into Payables without matching 
to a purchase order default to one unit only. You can update the number of units in the Mass 
Additions window. Refer to Fixed Assets User Manual. 

After you approve and post the invoice in Payables, run the Create Mass Additions for Oracle 
Assets process to send valid invoice line distributions to Oracle Assets. 

 

Handle Returns 

You can easily process and track returns using mass additions. For example, you receive an 
invoice, post it, and create an asset using mass additions. You then discover that the asset is 
defective, and you must return it. 

First you reverse the invoice in Payables, charging the credit invoice line distribution to the 
same asset clearing account. Then you run mass additions to bring over the credit line. Add 
this line to the existing asset to bring the asset cost to zero. Now you can retire the asset. The 
asset does not affect your balance sheet, but its audit trail remains intact. 

 

Conditions For Asset Invoice Line Distributions to be Imported. 

For the mass additions create process to import an invoice line distribution to Oracle Assets, 
these specific conditions must be met: 

• The line is charged to an account set up as an Asset account. 

• The account is set up for an existing asset category as either the asset clearing account 

or the CIP clearing account. 

• The Track as Asset check box is checked. (It is automatically checked if the account is 

an Asset account) 

• The invoice is approved. 

• The invoice line distribution is posted to Oracle General Ledger from Payables 

• The general ledger date on the invoice line distribution is on or before the date you 

specify for the create program. 

• Your installation of Payables must be tied to the same general ledger set of books as 

the corporate book for which you want to create mass additions. 
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4.3 Create Mass Additions in Payables 

 

To Create Mass Additions for Oracle Assets Program in Payables 

1. Navigate to:  Payables > Invoices>Task >Create Mass Additions 

 
Figure 25: Create Mass Additions Navigation 

 

2. The Scheduled Processes Window for Create Mass Addition will prompt. 

 

Figure 26: Create Mass Addition Scheduled Process Window 

 Enter the parameter below:  

Fields Description 

Accounting date You can enter a date in the current or a prior 
accounting period. 

Asset Book Chosen Oracle Assets corporate book for mass 
addition. 
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Attention: Verify that you are creating mass 
additions for the correct corporate book in Oracle 
Assets, because you cannot undo the process and 
resend them to a different book. 

 

Table 14: Parameter to run Create Mass Addition Scheduled Process 

 

3. Click Submit 

You can run Create Mass Additions for Oracle Assets as many times as you like during a 
period. Each time it sends potential asset invoice line distributions and any associated discount 
lines to Oracle Assets. Payables ensures that it does not bring over the same line twice. 

After you create mass additions, review them in the Mass Additions window. 

Mass Additions lets you add assets and cost adjustments directly into Oracle Assets from 
invoice information in Payables. The Create Mass Additions for Oracle Assets process sends 
valid invoice line distributions and associated discounts from Payables to an interface table in 
Oracle Assets. Then you review them in Oracle Assets and determine whether to create assets 
from the lines.  
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5 PAYMENT PROCESSING 

5.1 Single Payment  

Single payments are used to accommodate last-minute supplier requests by quickly creating 
off-cycle payments. You can create and print a payment to pay a supplier for one or more 
invoices. When you create a single payment, you can select an invoice regardless of the 
payment terms, payment method on the invoice instalments and due dates. The invoices that 
you are going to select for the purpose of releasing a single payment must have been validated 
and approved. The status of those invoices should not be cancelled, and those invoices should 
always be without holds.  

 

There are some restrictions as far as the Single Payments are concerned.  

1. You can select only invoices that have the same supplier site as the payment supplier site. 

2. The system adjusts the list of values to ensure that you do not pay a pay-alone invoice 

when you pay multiple invoices. If you have selected an invoice for payment and then you 

select more invoices for payments, payables do not include pay-alone invoices on this list 

of values. If you select a pay-alone invoice for payment, you cannot select more invoices.  

3. You can pay an invoice in any currency, provided multiple currency is enabled. If multiple 

currency is not enabled, then you must pay in the same currency which is the currency of 

your invoice. 

 

There are two ways in which the single payments can be initiated. The first option is by 
navigating to the payments work area. And the second option is by using the invoices work 
area. So, when you are creating an invoice or when you are editing an invoice, when you click 
on the Invoice Actions dropdown, you get an option as Pay in Full. When you use the Pay 
In Full option, system allows you to initiate a single payment against that invoice. 

For the first option where you are navigating through the payments work area and you are 
choosing the Create Payments task, you have the option to choose multiple invoices for the 
supplier that you have selected for initiating the payment.  

 

 

Figure 23: Creating Payment 
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To create single payment 

1. Navigate to:  Payables > Payment > Task > Create Payment 

2. Enter the details below: 

Fields Description 

Business unit Choose the business unit for which you want to 
create payment from 

Supplier / Party Select the party for whom the payment must be 
initiated. 

Payment Date Enter the payment date 

Type Select 

Quick: single payment that is created without 
submitting a payment process request, and it is 
always going to be used for initiating the payment 
for a single supplier. 
 
Manual: For payment that is created outside of 
Payables, and then recorded in Payables 
 
Refund: Payment for a negative amount that 
closes an outstanding credit balance. To record a 
refunded transaction, you will record that refund 
transaction based on the check that you have 
received from your vendor.  
 

Disbursement Bank Account Select Preferred Bank Account from where the 
money to be disbursed 

Payment Method Select Payment Method 

Payment Process File Select Payment Process File 

LSE PPP – for Online Transfer, Cash, & Wire 

LSE PPP Check – for Check payment 

Table 9: Fields for Creating Single Payment 

 

3. Then from Invoices to Pay Tab 

4. Click Select and Add   

5. A window will prompt the user to search and select the invoice for the payment. Once 

selected, click "OK". 

6. Once done Click Save and Close 
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5.2 Payment Batches via Payment Process Request  

 

A standard payment process request typically contains multiple documents payable to be paid. 
These documents are processed in batch mode, where they are first built into payments, and 
then the payments are built into payment files for final disbursement, whether in the form of a 
check or by electronic processing. You can submit a payment process request using the submit 
payment process request task within the payments work area. 

 

To create Payment Process Request 

 

1. Navigate to:  Payables > Payment > Task > Submit payment process requests. 

 

Figure 24: Submitting payment request 

 

2. Provide a Name and You can also choose a Template. If you have already created a 

template, you can select a template, and the values you have provided at the time of 

creating the template will be auto filled in the respective attributes on both the Selection 

Criteria tab as well as on the Payment and Processing Options tab.  

3. If no template is chosen, enter the attributes for Selection Criteria Tab and Payment 

and Processing Tab. 

 

Selection Criteria Tab 

You can choose below Selection Criteria 

Fields Description 
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Paid Through Date Latest due date for an instalment 

Pay From Date Earliest due date for an instalment 

From Payment Priority Lowest payment priority assigned to an instalment. 

To Payment Priority 
Highest payment priority assigned to an 
instalment. 

Date basis Basis for the date that affects instalment selection 
and whether to take a discount. 

Include Zero amount invoices Include invoices that have a zero-amount due. 

Pay Groups Invoice categorization for payment. The default 
setting includes all pay groups, but you can specify 
one or more pay groups. 

Currencies Currencies for invoices and payments. The default 
setting includes all currencies, but you can specify 
either one or more invoice currencies, or one or 
more payment currencies. 

Business Units Business units for invoices and payments. The 
default setting includes all business units. If you 
specify: 

A payment business unit, the selection process 
finds instalments for the invoice business units that 
the payment business unit services. 

An invoice business unit, the selection process 
finds instalments for that invoice business unit. 

Legal Entities Legal entity associated with an invoice. The default 
setting includes all legal entities, but you can 
specify one or more legal entities. 

Sources The sources are used to separate one-time 
payments which were created as payment sources, 
such as insurance reference or student reports 

Supplier Type Supplier classification, such as tax authority or 
contractor. 

Payment Method Method of payment for an instalment. 

Invoice Conversion Rate Type of the rate that converts the invoice currency 
to the ledger currency 

Supplier/Party Supplier or party on an invoice. 

If you want to include the invoices of a specific 
supplier or party, then you can choose a specific 
name of that party in this field. 
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Invoice Group 
A user-defined name assigned to one or more 
invoices. 
 
Note: If you implemented centralized payment 
processing, the service provider setup and your 
business unit access affect the list of values in the 
Invoice Group field. The invoice groups are from 
the invoice business units that are serviced by the 
payment business units that you have access to. 

Table 10: Fields for Selection Criteria Tab-Payment Process Request 

 

Payment and Processing Options tab 

You can choose below Payment Attributes 

Fields Description 

Payment Date Effective Date of The Payment 

Disbursement Bank Account Internal Bank Account That Is Used for The 
Payment 

Payment Document Either Printed or Electronic. 

Payment Process Profile Select Payment Process File 

LSE PPP – for Online Transfer, Cash, & Wire 

LSE PPP Check – for Check payment 

Payment Conversion Rate 
Type 

If You're Processing a Payment In A Currency 
Other Than The Functional Currency, The 
Conversion Rate Type Is Used To Convert The 
Payment To The Functional Currency. 

Settlement Priority Override 
Option 

Override The Payment Process Profile Settlement 
Priority 

Bank Charge Bearer Override This Is the Party That Agrees To Assume The 
Liability For Bank Charges Assessed On A 
Transaction, Which Can Be Overridden By Another 
Party 

Starting Voucher Number If You Are Using Voucher Numbers, You Can Enter 
The Starting Number For The Payment 

Cross-Currency Rate Type This Is The Conversion Rate Type That Is Used To 
Convert The Invoice Currency To The Payment 
Currency. Use this for cross-currency payment 

Table 11: Fields for Payment and Processing Options tab-Payment Process Request 

 

For Processing Options, enable or disabled the flags based on your requirement. 
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Fields Description 

Apply credits up to zero 
amount payment 

Applies credits and creates a zero-amount 
payment if the sum of the selected instalments is 
negative after the instalments are grouped for 
payment. 

Note: If you set this option and bank charges apply, 
the payment process request rejects the 
instalments because they might reduce the 
payment amount less than zero.  

 

Review instalments 
Stops the payment process request after selecting 
the instalments. You can: 
• Review instalments 
• Add or remove instalments 
• Edit payment and discount amounts 
• Specify user conversion rates 
• Calculate withholding and interest 

Review proposed payment Stops the payment process request after grouping 
instalments into payments and before building the 
payments. 

Create payment files 
immediately 

Creates payment files for the submitted request 
instead of waiting to combine payments from other 
requests into payment files. 
Notes: Make sure this is enabled to ensure your 
PPR is created successfully. 

Table 12: Processing Option for Payment Process Request 

 

Another Control on Processing Option 

Fields Description 

Validation failure handling for 
documents 

Specifies processing instructions for handling 
document validation failures. 

Validation failure handling for 
payments 

Specifies processing instructions for handling 
payment validation failures. 

Table 13: Validation Failure Handling Control for Payment Process Request 

 

4. Once you have provided the values in each one of these attributes, Click on Submit.  

5. Job will be initiated to first select the instalments.  

6. Review the instalment and resubmit the process if satisfied and System will build the 

payments.  

7. Review the payments and you will proceed further with formatting, electronic 

transmission, or printing of the checks. 
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6 NETTING PROCESSING 

6.1 Manage Netting Agreement 

 

A netting agreement controls how a group of trading partners net Payables and Receivables 
transactions. You can create a netting agreement for each group of trading partners that 
agrees to net transactions. Netting agreements include the business rules that define the types 
of transactions that may be selected for netting, and which suppliers and customers can be 
netted. 

Access the Netting Agreement user interface from either the Payments work area in Payables, 
or the Accounts Receivable work area in Receivables. Click on the ‘Task List’. The ‘Manage 
Netting Agreements’ link is under the ‘Customer and Supplier Balance Netting’ section 

 

Task name: Manage Netting Agreements 

Navigation: Navigator > Payments > Task List > Manage Netting Agreements 

 

 

Navigation: Navigator > Accounts Receivable > Task List > Manage Netting Agreements 

 

 

Searching Agreements 

In the search window, you can find agreements that you have already created. By default, the 
search will only select active agreements that have not been end dated, but you can change 
this in the ‘Active Netting Agreement’ field. 
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Creating Netting Agreements 

When creating a new agreement, there are six main components that model the agreement, 
and each component will be described in turn. 

 
1. Business Rules and Preferences 
2. Pay Groups 
3. Payables Invoice Types 
4. Receivables Transaction Types 
5. Trading Partners 
6. Letters 

  

 

 

 

Business Rules and Preferences 

 

The netting agreement business rules and preferences indicate the high-level details and 
preferences that apply to your agreement between yourself and a trading partner. 

 

Business Rules Region 

 

• Select the ‘Legal Entity’ for the agreement. Netting is performed for the Legal Entity. If 

you have multiple business units assigned to a legal entity, they will all be assessed for 

netting.  

Notes: the Netting manager can only net invoices that he/she has access to by virtue of 
their business unit security. 

 

• Enter an ‘Agreement Name’. 

• Optionally enter a ‘Trading Partner Reference’ from your third party with whom the 

agreement is with. 
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• Enter a ‘Start Date’ for the agreement. This should reflect the contractual start date with 

the third party. 

• Optionally enter an ‘End Date’ for the agreement. Settlements can only be created for 

agreements provided the date of the settlement is within the ‘Start Date’ and ‘End Date’ 

range. Therefore, if the agreement has come to an end between yourself and the third 

party, you must end date the agreement. This will prevent further netting settlements 

from taking place for the agreement and it can no longer be used for processing netting. 

 

Netting Preferences Region 

The netting preferences dictate how you want to manage the transactions in an agreement. 

 

• Select the ‘Netting Bank Account Name’. Only active bank accounts that have the 

‘Netting account’ checked will be available for selection.  See the ‘Netting Bank Account 

Setup’ section in ‘Feature Specific Setup’. 

• Select the ‘Netting Order Rule’. The rule indicates the priority in which transactions will 

be selected for netting. You still could find tune the ordering of netting transactions once 

a settlement has been selected in the ADFdi spreadsheet download. 

o Defaults to ‘Due date from oldest to most recent’. Select this if you want to clear 

transactions that are past or near the due date first. 

o Ascending Amount. Select this if you want to clear many small transactions first. 

o Descending Amount. Select this if you want to clear the larger amount 

transactions first. 

o Transaction date from oldest to most recent. 

 

• Select the ‘Netting Balance Rule’. The rule determines the conditions when to net. If 

you want to restrict the netting to only take place when the balance of payables invoices 

is greater than the balance of receivables transactions, then choose: 

o ‘Net when Payables is greater than Receivables’. Otherwise, select 

o ‘Net Always’ 

• Optionally assign a ‘Netting Group’ to your agreement. See the ‘Netting Group Setup’ 

section in ‘Feature Specific Setup’ and ‘Appendix – Netting Group setup Example’. 

• Check the ‘Allow early settlement discount’ checkbox if you want to ensure that eligible 

discounts are applied to the amounts. See ‘Appendix – Discounts working Example’ for 

further details. 

• Select the ‘Netting Currency Rule’. If you want to settle for invoices and transactions 

for a particular currency (e.g. GBP), then you can set the netting currency rule to ‘Use 

Single Currency’. You can then select the ‘Currency’. If you have invoices in 

transactions for multiple currencies, you can select ‘Net within each currency’. For 

example, if you have GBP and EUR invoices/transactions that you want to net, a 

settlement will be created for each currency (one for GBP and another for EUR). Both 

settlements can then be treated independently of one another. Ensure the Netting Bank 

Account has the Multicurrency checkbox checked. Netting will only net invoices of the 

same currency together i.e. GBP with GBP or EUR with EUR. It will not net GBP with 

EUR. 
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Pay Groups 

If you want to allow all payables invoices to be available for a settlement, regardless of which 
pay group is assigned to the invoice, then choose ‘All’. This is the default option. 

 

• Only Include Option: 

If however, you have a scenario where you want to restrict the invoices for selection to only 
those that belong to one or more pay groups, then select ‘Only Include’ and add one or more 
‘Pay Groups’ that you wish to assign to the agreement. The settlement process will then only 
select invoices that belong to the pay group(s) that are included on the agreement. 

 

• Only Exclude Option: 

If however, you have a scenario where you want to exclude invoices for selection to only those 
that belong to one or more pay groups, then select ‘Only Exclude’ and add one or more ‘Pay 
Groups’ that you wish to exclude from the agreement. The settlement process will then only 
select invoices that do not belong to the pay group(s) that are excluded on the agreement. 

See the ‘Pay Group Setup’ section in ‘Feature Specific Setup’ on how to setup the pay groups 
prior to invoice processing. 

 

 

  

Payables Invoice Types 

Restrict the types of payables invoices that are eligible for netting by indicating which types of 
payables invoices to be considered. The three types of payables that you can assign to the 
agreement are: 

 

• Standard (added by default) 

• Credit Memo 

• Debit Memo 
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Therefore, if you only want to set the standard invoices and credit memos, you can do so by 
just selecting those 2 options from the list of values. The settlement process will then not pull 
the ‘Debit Memos’ in payables. Payables Invoice types are seeded by Oracle and cannot be 
changed or added to. 

 

Receivables Transaction Types 

Similar to the ‘Pay Group’ filtering, you can restrict the types of receivables transactions that 
are eligible for netting by indicating which ‘Receivables Transaction Types’ to include or 
exclude for netting. 

 

If you want to allow all receivables transactions to be available for a settlement, regardless of 
which transaction type is assigned to the transaction, then choose ‘All’. This is the default 
option. 

• Only Include Option: 

In the example above, the agreement is setup such that only 2 of the transaction types are 
included for netting to take place. If there are other receivables transactions that are not 
assigned to either of the 2 transaction types, they will not be selected. Receivables transaction 
types may be extended – see the ‘Manage Transaction Type Setup’ section in ‘Feature Specific 
Setup’. 

 

• Only Exclude Option: 

If however, you have a scenario where you want to exclude transactions for selection to only 
those that belong to one or more transaction types, then select ‘Only Exclude’ and add one or 
more ‘Transaction Types’ that you wish to exclude from the agreement. The settlement process 
will then only select transactions that do not belong to the transaction types that are excluded 
on the agreement. 

 

Trading Partners 

The ‘Trading Partners’ tab allows you define the suppliers and customers that you want to net 
transactions. In the example below the agreement is between ‘MyBusiness PlC’ and 
‘MyThirdParty’. ‘MyThirdParty’ is defined as: 
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• A supplier with 2 sites 

• A customer with 1 site 

The association on the agreement will result in payables invoices from the 2 supplier sites 
being selected and the receivables transactions from the single customer site. 

Multiple supplier and customer names can be joined together to represent the third-party 
relationship for netting. 

 

  

Select Supplier Region 

• Select one or more ‘Supplier Names’ that represents the suppliers you wish to net 

invoices. The ‘Supplier Number’ and ‘Supplier Tax Registration Number’ from the 

supplier profile, display for validation. 

• Optionally select one or more ‘Supplier Sites’ for the ‘Supplier Name’. If you want to 

include all supplier sites for netting, then leave the ‘Supplier Site’ field blank. If you do 

select a ‘Supplier Site’, the ‘Site Tax Registration Number’ displays for validation 

purposes 

• The netting process will rank the invoices from the suppliers based on 

the ‘Priority’ for the ‘Suppliers’. In 

the example above, the invoices for ‘Valencia Div’ will be prioritized ahead of those from ‘My 
Second Address’. There is further opportunity to change the invoices for selection once a 
settlement has been selected. 

 

Select Customer Region 

• Select one or more ‘Customer Names’ that represents the customers you wish to net 

transactions. The ‘Customer Number’ and ‘Customer Tax Registration Number’ from 

the customer profile, display for validation. 

• Optionally select one or more ‘Customer Sites’ for the ‘Customer Name’. If you want to 

include all customer sites for netting, then leave the ‘Customer Site’ field blank. If you 

do select a ‘Customer Site’, the ‘Site Tax Registration Number’ displays for validation 

purposes 

• The netting process will rank the transactions from the customers based on the ‘Priority’ 

for the ‘Customers’. In the example above, there is just one ‘Customer Site’ selected, 

so the priority does not matter. More complex relationships may require you to order 



Olivestouch Technologies Sdn Bhd 
User Manual 

Payable Module v1.0 

 

Confidential  Page 70 of 112 

 

the priority of the customer and customer sites to ensure you net transactions from 

certain customer representations first. 

Letters 

The Letters tab allows you to configure how you want the Netting Letter to be distributed to 
your third party. The letter is a confirmation to the third party that the invoices have been netted, 
listing all the invoices and transactions that were included in the netting amount. 

 

 

Letter Preferences 

• When you first create an agreement, the default is to enable ‘Generate Netting Letter’. 

If you do not want letters to be generated to send to your third party, then you can 

disable this by un-checking the ‘Generate Netting Letter’ checkbox. You can save the 

record, and the ‘Agreement’ setup is complete. 

• If you wish to email the netting letters to the third party, enable the ‘Send Letters by E-

Mail’ checkbox. 

Netting Letter Contacts 

• If you have enabled the ‘Generate Netting Letter’, the letter will be sent to the ‘Recipient 

Address’. This is defaulted from the ‘Supplier Address’ of the highest priority supplier 

site which is ‘Primary Pay’ and entered on the Trading Partner tab. You can, however, 

override this address to any other address for the supplier/customer combination that 

you define in the Trading Partner tab. The address you select will be the address that 

appears on the ‘Netting Letter’. 

• Select the ‘Language’ in which you want the letter to be presented to the customer. The 

value will default from the Site Language of the supplier site that is selected in the 

'Recipient Address'. 

• If you have enabled the ‘Send Letters by E-Mail’ option, you must also enter the: 

o ‘To E-Mail’. Enter the email address that the letter will be emailed to. If the letter is 

for multiple sites, the third party will have to distribute this themselves internally. 

Therefore, you can only send the letter to a single email address. It is defaulted 
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with the Primary contact of the supplier site that is defaulted/selected in 'Recipient 

Address' [email is primary contact’s email address]. You can overwrite this to a 

different email address if required. 

o ‘From E-Mail’. Enter the email address that will appear on the recipients ‘From E-

Mail’. This should be the person or department email that created the settlement. 

The value will default from the ‘Statement Delivery Using E-Mail: From E-Mail’ from 

the Receivables System Options if it exists. You can overwrite this to a different 

email address if required. 

o ‘From Name’. Enter the ‘From Name’ that will appear on the netting letter. This 

should be the person or department email that created the settlement. The value 

will default from the ‘Statement Delivery Using E-Mail: From Name’ on the 

Receivables System Options if it exists. You can overwrite this to a different value 

if required. 

o Optionally enter a ‘Reply-to E-Mail’ address that will appear on the recipients ‘Reply 

to E-Mail’. This should be the person or department email address that will deal 

with any queries from the third party relating to the netting settlement. The value 

will default from the ‘Statement Delivery Using E-Mail: Reply-to E-Mail’ from the 

Receivables System Options if it exists. You can overwrite this to a different email 

address if required. 

 

 Saving a Netting Agreement 

When the sections above have been entered, you are ready to save the agreement. You can 
either ‘Save and Create Another’ agreement, or ‘Save and Close’. 

When you save the agreement, validation will run on the third-party entities and sites that have 
been entered. If the system detects that there are different Tax Registration numbers on the 
third party records a warning will display, asking for verification that you have selected the 
correct combination. 

 

 

This is intended to ensure you validate yourself the correct combination of suppliers, supplier 
sites, customers and customer sites have been selected for netting. 

 

Once an agreement has been saved, you can edit it later. However, the following attributes will 
not be able to be changed: 

• Legal Entity 

• Agreement Name 

You are now ready to create a Netting Settlement based on the Agreement that you have 
setup. 
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6.2 Manage Netting Settlement 

Task name: Manage Netting Settlements 

Navigation: Payments > Task List > Manage Netting Settlements 

Navigation: Receipts > Task List > Manage Netting Settlements  

Navigation: Tools > Schedule Processes > Generate Netting Settlements  

This section will cover: 

• Searching settlements 

• Creating a settlement from Manage Netting Settlements 

• Generating and Scheduling Netting Settlements 

• Reviewing a settlement 

• Modifying a settlement 

• Submitting a settlement 

• Deleting a settlement 

• Reversing a settlement 

• Downloading settlements to a spreadsheet 

 

6.2.1 Searching Settlements 

 

Search on existing settlements to action a settlement. Settlement actions can be: 

• Delete a settlement 

• Submit a settlement to create the netting 

• Reverse a settlement that has already been completed 

• Download a settlement to a spreadsheet for review and modification 

The search functionality allows you to find any settlement that has already been 

created. Use the filtering criteria of ‘Legal Entity’, ‘Settlement Name’, ‘Settlement 

Number’, ‘Status’ or ‘Agreement Name’. 

If the search results show at least one settlement in Selected or Selected, no transactions 

status, the Download Settlements button will be enabled. This will enable you to download 

and process settlements (Delete or Settle) in a spreadsheet. 

 

The results will be ordered by the most recently updated settlement. 
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To create a new settlement such as the following: 

 
 

• Choose the ‘Legal Entity’ for the first party. Only legal entities that have active 

agreements created for them will be available. 

• There are 3 methods of creating a settlement. See ‘Appendix – Netting Group setup 
Example’. 

 

o Create for ‘All Agreements’ that belong to the ‘Legal Entity’. Choose the ‘All 

Agreements’ radio button if you have multiple agreements for your Legal Entity 

and you want to perform netting en masse. 

o Create specific ‘Netting Groups’. Choose ‘All Agreements’ and select the 

‘Netting Group’ if you want to perform netting for a specific group of agreements 

assigned to your Legal Entity. 

o To create a single agreement, choose the ‘Specific Agreement’ radio button 

and then select the ‘Netting Agreement’ that you want to use for netting. 

 

• Select the ‘Settlement Date’. This relates to the date that netting will occur. This cannot 

be a prior date, and it defaults to today’s date. 

• The ‘Settlement Name’ will default to: Legal Entity + Agreement Option + Today’s 

Date. You can override the default to any other unique value. This is intended to help 

you track your settlements by a meaningful convention for your business. 

• If you wish to settle a settlement without reviewing the content, then select ‘Yes’ in the 

‘Settle Without Review’ field. However, it is strongly recommended that you leave 

this set to the default of ‘No’, so that you can internally verify and modify the 

settlement details prior to creating the settlement. 
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• Select the ‘Transaction Due Date’. All transactions will be selected in the netting 

process, provided their due dates are before or equal to the ‘Transaction Due Date’. 

Therefore, you can use this to net based on when transactions should be due, avoiding 

late payment charges. 

• Select the ‘Accounting Date’. All the payments and receipts that are created will have 

this accounting date stamped on them. 

• Select the ‘Conversion Rate Type’. This is the exchange rate that will be used when 

calculating any foreign currency transaction gains and losses. For example, your ledger 

currency may be in GBP, but the transactions may be in EUR. The default value will be 

derived from the Receivables Profile option: 

‘AR_DEFAULT_EXCHANGE_RATE_TYPE’. The ‘User’ level will take precedence. If 

that is not set, the ‘Site’ level will be defaulted.  If neither are set, then the value is 

defaulted to ‘Corporate’. 

 

 

In the example above, the default for the ’NETTING_MGR’ user is ‘RB Rate’. This value will 

be defaulted onto the ‘Create Netting Settlements’ UI. 

You can now submit the process to start creating settlements. You can either ‘Save and 

Create Another’ settlement, or ‘Save and Close’. Once you save the record, you will receive 

confirmation that the netting process has started. 

The netting process will then select all eligible invoices and transactions that meet the criteria 

on the netting settlement and the agreements to which they relate to. The netting process may 

create multiple settlement numbers depending on the following: 
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• Number of Agreements you have selected for netting settlement run. 

• Number of different currencies in the settlement (a settlement is created for each 

different currency of transactions) 

 

For example, if you have 5 agreements and 2 of those agreements contain 2 different 

currencies of invoices/transactions, you will have 7 different settlement numbers created for 

the settlement name. Each settlement will then be processed independently. 

 

6.2.2 Generating and Scheduling Netting Settlements 

 

If you prefer, you can schedule and generate Netting Settlements with the ‘Generate Netting 
Settlements’ process. 

This has the benefit of giving you the option to schedule netting at a time that is convenient 

for your business practices. For example, “Schedule all my agreements for the ‘Farming 

Netting Group’ on the last day of each month”. Also, it will allow you to submit settlements by 

‘Business Unit’ or ‘Legal Entity’ 

 

 



Olivestouch Technologies Sdn Bhd 
User Manual 

Payable Module v1.0 

 

Confidential  Page 76 of 112 

 

Parameters: 

 
 

• Business Unit: If you prefer to select all your agreements for a business unit, enter the 

‘Business Unit’ that you wish to run netting for. Note, although you can submit by 

business unit, netting is performed at the legal entity. In this case, all Legal Entities that 

share the same business unit will be considered for netting. 

• Legal Entity: Choose the Legal Entity for which you want to net for. You must enter 

either a ‘Business Unit’ or a ‘Legal Entity’ 

• Netting Group: Optionally select the ‘Netting Group’ for which you want to net. 

• Agreement Name: If you want to select a single ‘Agreement’ for netting, select the 

‘Agreement Name’. If you want all agreements to be processed, you can leave this. 
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• Select the ‘Settlement Date’. This relates to the date that netting will occur. This 

cannot be a prior date, and it defaults to today’s date. 

• The ‘Settlement Name’ will default to: ‘All + Today’s Date’. You can override the 

default to any other unique value. This is intended to help you track your settlements by 

a meaningful convention for your business. 

• If you wish to settle all the settlements without reviewing the content, then select ‘Yes’ 

in the ‘Settle Without Review’ field. However, it is strongly recommended that you 

leave this set to the default of ‘No’, so that you can internally verify and modify the 

settlement details prior to creating the settlement. 

• Select the ‘Transaction Due Date’. All transactions will be selected in the netting 

process, provided their due dates are before or equal to the ‘Transaction Due Date’. 

Therefore, you can use this to net based on when transactions should be due, avoiding 

late payment charges. 

• Select the ‘Accounting Date’. All the payments and receipts that are created will have 

this accounting date stamped on them. 

• Select the ‘Conversion Rate Type’. This is the exchange rate that will be used when 

calculating any foreign currency transaction gains and losses. For example, your ledger 

currency may be in GBP, but the transactions may be in EUR. 
 

To submit the process, click the ‘Submit’ button. All the agreements that meet the criteria 

when submitting the job will be processed. For example, if you had 20 agreements assigned 

to the ‘Netting Farming Group’, and ‘Settle Without Review’ = ‘Yes’, then all 20 agreements 

would be processed and automatically settled. Depending on your agreement setup, letters 

will also be emailed to your third parties. 

 

All the settlements created will be available for inspection from the ‘Manage Netting 

Settlements’ task. Spreadsheets will be available for download for each settlement created. 

 

6.2.3 Reviewing a Settlement 

 

Assuming you have opted to review the settlement prior to the creation of payments and 

receipts, you can review the proposed settlement in a spreadsheet. It is necessary to review 

the content, so that you have confirmed that the correct set of invoices and transactions are 

being selected for netting. This is the last chance to alter the settlement before the netting 

process creates the payments and receipts. 

 

Click on ‘Actions’->’Download Settlement to Spreadsheet’, or you can download to excel 

from the download link for the settlement search results table for your settlement number. 
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An ADFdi excel file with then be downloaded which you can open to review the details of the 

settlement. Ensure you have the ‘Oracle ADF Desktop Integration Add-In for Excel’ installed. 

 

 

6.2.3.1 Netting Toolbar 

You can then open the file and connect to the instance. In the excel ribbon, you will see the 

‘Netting Settlement’ menu. If you make changes to the settlement via the ADFdi 

spreadsheet prior to submitting the final settlement, you must click the ‘Upload Settlement’ 

icon. 

 

 

6.2.3.2 Netting Summary 

The summary information appears on both tabs (‘Payables’ and ‘Receivables’). For example, 

the following fields apply. 

 

• Settlement Number that was generated during the process 

• Settlement Name you entered 

• Agreement Name that the settlement was created for 

• Status of the settlement when you download the spreadsheet (e.g. Selected, Reversed or 
Settled) 

• Payables Amount: The total amount of Payables Invoices for your suppliers are summed 
up 

• Receivables Amount: The total amount of Receivables Transactions for your customers 
are summed up 

• Proposed Netting Amount: This represents the amount that can be netted. In this 

example the amount is equal to the total Payables Amount, indicating that all the Payable’s 

invoices can be netted, but there will be some receivables transactions that cannot be 
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netted in the settlement. It is ‘Proposed’ since at this point, no payments or receipts have 

been processed. 
 

You can fine tune the settlement and modify it. This is explained in the next section. 

 

6.2.3.3 Payables Invoice Details 

The ‘Payables’ tab lists the invoices that were selected for Netting. 

 

 

Key Columns: 

• Changed/Exclude/Row Status: These are indicators that track which rows are being 
removed or changed. 

• Rank: The order in which the final netting process will net the invoices. The ranking can be 

changed in case you want to exclude or include other payables invoices in the netting 

settlement. 

• Invoice Number: The invoice that is selected by the process as a candidate to be netted. 

• Invoice Type: The payables invoice type. Only invoice types that you selected in the 

agreement setup will be selected. 

• Supplier Name, Number and Site: The supplier details indicate the trading partner in 

Payables that the invoice relates to. 

• Invoice Date: The date stamped on the invoice in payables. 

• Invoice Amount: The total invoice amounts payable. 

• Open Amount: The amount that will be netted. 

• Invoice Currency: The invoice currency on the payables invoice. 

• Settlement Currency: The currency that the invoice will be settled in. 

6.2.3.4 Receivables Transaction Details 

The ‘Receivables’ tab lists the transactions that were selected for Netting. 

 

 

Key Columns: 

• Changed/Exclude/Row Status: These are indicators that track which rows are being 
removed or changed. 

• Rank: The order in which the final netting process will net the transactions. The ranking 

can be changed in case you want to exclude or include other receivable transactions in the 

netting settlement. 
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• Transaction Number: The transaction that is selected by the process as a candidate to be 

netted. 

• Transaction Type: The receivables transaction type. Only transaction types that you 

selected in the agreement setup will be selected. 

• Customer Name, Number and Site: The customer details indicate the trading partner in 

Receivables that the transaction relates to. 

• Transaction Date: The date stamped on the invoice in receivables. 

• Transaction Amount: The total invoice amount receivable. 

• Open Amount: The amount that will be netted. 

• Transaction Currency: The transaction currency on the receivable’s transaction. 

• Settlement Currency: The currency that the transaction will be settled in. 
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6.2.4 Modifying a Settlement 

After review of the proposed settlement, you may wish to decide to: 

• Remove some invoices or transactions from the proposed settlement. 
 

 
o Double click the ‘Exclude’ cell for the invoice or transaction number. 

o A ‘blue dot’ indicates that the record is selected for exclusion. 

o Save changes – Click the ‘Upload Settlement’ menu item. 

o The Payables or Receivables Amount will be decreased in the spreadsheet. 

 

• Add other invoices or transactions into the settlement that were not originally selected as 

part of the process since they did not adhere to the settlement criteria. For example, adding 

a transaction that was 

initially had the ‘Exclude from Netting’ set to ‘Yes’, but subsequently you do wish to include 

after updating the transaction to remove the exclusion 

o Add a new row in excel 

o Double click the ‘Invoice Number’ (if you want to add a payables invoice) or the 

‘Transaction Number’ (if you want to add a receivables transaction) 
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o Search for the ‘Invoice Number’ (Payables) or ‘Transaction Number’ (Receivables). 

Once you have selected your invoice or transaction, it will be added into the spreadsheet. 

o The Row Status will change, indicating that you have new data. 

o Save changes – Click the ‘Upload Settlement’ menu item. The row status will indicate that 

the row has been inserted successfully. 

o The Payables or Receivables Amount will be increased in the spreadsheet. 

 

• Reorder some invoices or transactions to force them to be netted. For example, you notice 

that you have a very important invoice that you want to be netted. However, since the AP 

total amount is substantially more than the AR total amount there is not enough AR balance 

to net with AP. You can increase the ranking of the AP invoice to 1 to force the invoice to be 

netted. 
 

 

Confirmation that the row is being updated is reflected by the blue triangle in the ‘Changed’ 

column for the invoice or transaction that you have modified. 

 

o Save changes – Click the ‘Upload Settlement’ menu item. 
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At this stage, the proposed settlement has been created, reviewed and modified. The 

settlement is now ready to be submitted for the netting to take place. 

 

6.2.5 Submitting a Settlement 

Submitting a settlement that is in ‘Selected’ status will run the settlement process to create 

the payments and receipts. Depending on the ‘Netting Letters’ setup, the netting letter may 

be automatically submitted from the netting routine. 

 

6.2.5.1 Submit a Settlement 

To submit a settlement: 

 

• Search for the settlement in the ‘Manage Netting Settlements’ user interface. 

• Select the row. 

• Click on ‘Actions’ -> ‘Submit Settlement’. 

• A confirmation will show, indicating that the process has been submitted. 
 

 

• Refresh the data in the settlement table. 

• The settlement will change from status ‘Selected’ to ‘Clearing’. This indicates that the 

payments and receipts are being created in payables and receivables. 
 

 

• When the settlement is complete, the settlement will change to ‘Settled’. Click on to 

check for completion. 

 

During the settlement process, the following reports are also run: 
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• Netting Report: Lists all the invoices and transactions with details on the amounts netted. 

• Netting Letter: If you have enabled the ‘Generate Netting Letter’ a netting letter is produced 
for your third party. If you enabled the ‘Send Letters by E-Mail’ option, the letter will 
automatically be sent to the third-party contact. See the ‘Letters’ section in ‘Netting 
Agreement Setup’. 

 

6.2.6 Review Settlement Details 

To review the settlement details (prior to final submission) such as: 

• Payment Numbers 

• Receipt Numbers 

• Invoices Netted 

• Transactions Netted 

• Invoices not Netted (Payables balance is greater than Receivables balance) The Netting 
manager should: 

• Search for the ‘Settlement’ in the ‘Manage Netting Settlements’ user interface. 
 

 

• Click the ‘Download’ link to download the spreadsheet. 

• Open the spreadsheet to review the details. Connect to the environment when prompted. 

• Example Output (Payables Tab): 

 

o The ‘Payment Number’ is shown indicating the payment number that was stamped on the 

invoice in payables. 

o The total ‘Netting Amount’. This is the sum of the payables invoices that were 
successfully netted. 

o The ‘Netted Amount’ for each payables invoice. 

 

o If ‘Payables’ > ‘Receivables’, some invoices will not be netted. An invoice can be 

partially netted. The netting manager can review these details in the spreadsheet. The 

‘Netted Amount’ will be zero or will be less than the ‘Invoice Amount’. 
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o ‘Payment Numbers’ will be blank, indicating that the invoice was not netted. The 

invoice will be made available for the next netting settlement, or it can be paid in 

payables. 

o ‘Netted Amount’ of invoices that were not netted will have zero in the ‘Netted Amount’ 
column. 

o ‘Partially Netted Invoices’ can be identified as those that have an ‘Invoice Amount’ 
that is greater 

than the ‘Netted Amount’ and the ‘Netted Amount’ is not zero. In such cases, the 

invoice has been partially paid. Partial payments may be used in future settlements, or 

the balance may be marked as paid in the traditional business process outside of Netting. 

 

• Example Output (Receivables Tab): 

 

o The ‘Receipt Number’ is shown indicating the receipt number that was stamped on the 

transaction in receivables. 

o The total ‘Netting Amount’. This is the sum of the receivables transactions that were 

successfully netted. 

o The ‘Netted Amount’ for each receivable’s transaction. 

 

 

6.2.7 Deleting a Settlement 

 

If a settlement has been created and is in ‘Selected’ or ‘Selected no transactions’ status, 

and you have decided that the settlement is no longer required, you can delete a settlement 

as follows: 
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To delete a settlement: 

• Search for the settlement in the ‘Manage Netting Settlements’ user interface. 

• Select the row. 

• Click on ‘Actions’ -> ‘Delete Settlement’. 

o A warning will show: 

 

 

o Deleting a settlement releases the transactions from the settlement to be available for 

future netting settlements.  Click ‘Yes’ to confirm. 

 

The settlement will no longer be in the settlement’s user interface. Settlements that have 
already been ‘Reversed’ or ‘Settled’ cannot be deleted. 

6.2.8 Reversing a Settlement 

If a settlement has been created and is in ‘Settled’ status, indicating that the payments and 

receipts have already been created, but you have realized that the settlement was 

erroneously created, you can ‘Reverse’ a settlement as follows: 

 

To reverse a settlement: 

 

• Search for the settlement in the ‘Manage Netting Settlements’ user interface. 

• Select the row. 

• Click on ‘Actions’ -> ‘Reverse Settlement’. 

o A warning will show: 

 

o Reversing a settlement will void the payments and reverse the receipts. The invoices 

and transactions from the settlement will then be available once again for future netting 

settlements. Click ‘Yes’ to confirm. 

o A confirmation will appear indicating that the process to reverse has been submitted. 

o Refresh the data in the settlement table. 

o The settlement will change from status ‘Settled’ to ‘Reversed’. This indicates that 

the payments have been voided and receipts are now reversed. 
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o A netting reversal letter is then automatically created which can be emailed or sent 

to the third party, indicating that the payments and receipts have been reversed. 

o See the ‘Netting Reversal Letter’ section in ‘Netting Reporting’. Only settlements 

that are ‘Settled’ can be ‘Reversed’. 

6.2.9 Downloading Settlements to a Spreadsheet 

In some circumstances, you may want to process multiple settlements at once because either 

you have large volumes, or you want to settle multiple settlements. 

 

To download settlements to a spreadsheet for processing: 

• Search for the settlements on the Manage Netting Settlements page. 

• Click the Download Settlements button. 

Note: If the search results show at least one settlement that is in either Selected or Selected, 

no transactions status, then the Download Settlements button will be enabled: 

 

• All settlements in the search results that are in either Selected or Selected, no 

transactions status will be downloaded to a spreadsheet. Settlements in other statuses are 

not downloaded. 

• Open the spreadsheet. 
 

• Select the Manage Netting Settlements tab on the ribbon. 

• To delete settlements: 

In the Settlement Status dropdown, select Delete settlement. 
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• To submit settlements to be processed: 

In the Settlement Status dropdown, select Settle settlement. 
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• If you want to leave settlements in either Selected or Selected, no transactions statuses, 
keep the 

Settlement Status field unchanged. 

 

Note: The fields that you can change in the spreadsheet are the Settlement Status fields. 

And you can only make these changes: 

 

Original Settlement Status Can be changed to … 

Selected Delete settlement 

Selected Settle settlement 

Selected, no transactions Delete settlement 

 

If you try to make other status changes (for example, changing a settlement from Selected 

to Selected, no transactions), the spreadsheet will revert to the original status for that 

settlement. 

 

• Once you complete your updates, click Save and Submit Settlements on the Manage 
Netting Settlements 

ribbon. 

 

• Settlements that were marked as Delete settlement, will be deleted. They will no longer 

appear on the spreadsheet or the Manage Netting Settlements page. 

• Settlements that were marked as Settle settlement, will be settled. The settlements process 

will create payments and receipts for all invoices and transactions for all settlements marked 

as Settle settlement. Once settled, you can review the content from the Manage Netting 

Settlements page. 

• The spreadsheet will automatically refresh. It will now list the remaining settlements that were 

unchanged, for review or further processing.



Olivestouch Technologies Sdn Bhd 
User Manual 

Payable Module v1.0 

 

Confidential  Page 90 of 112 

 

6.2.10 Netting Settlement Letter 

 

The netting letter is automatically run when the netting manager submits a settlement or 
creates a settlement without review. Access the report from the ‘Financial Reporting Centre’. 
The letter lists: 

 

• Payables Invoices that were netted, showing the: 

o Invoice Number 

o Invoice Type 

o Invoice Date 

o Invoice Amount 

o Netted Amount 

o Invoice Currency 

o Invoice Total 

o Netted Total  

 

Example: 

Only Payables invoices that were netted are listed. 

 
 
 

Receivables Transactions that were netted, showing the: 

o Transaction Number 

o Transaction Type 

o Transaction Date 

o Transaction Amount 

o Netted Amount 

o Transaction Currency 

o Transaction Total 

o Netted Total 
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Example: 

 

 

The ‘Netting Settlement Letter’ can be automatically sent via E-Mail to the ‘Third Party’. See 
the ‘Letters’ section in ‘Netting Agreement Setup’.
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7 PERIOD CLOSING 

6.1 Create Accounting Process 

The Create Accounting process is an Oracle Enterprise Scheduler process. It can be 
submitted as a request to create journal entries for a batch of events. It has input parameters 
that determine the execution mode and the selection criteria for events.  

 

To Create Accounting Process 

 

1. Navigate to Payables> Invoices/Payments>Create Accounting 

 

Figure 27: Navigation to Create Accounting Process 

 

2. The Scheduled Processes Window for Create Accounting will prompt. 

 

Figure 28: Create Accounting Scheduled Process Window 
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Enter the parameter below for the process. 

Fields Description 

Subledger Application Payables 

Ledger Ledger name for which the Create Accounting 
process is being executed.  

Example: ABC LEDGER  

End Date End date puts a filter on the selection of events. 
Only events having event date before the end date 
are selected for accounting. Defaults to SYSDATE. 

Accounting mode Accounting mode; Draft or Final 

Default value is Final. 

Process Events Adds other filter criteria for the Create Accounting 
process to select events. 

All: Process all events. 

Errors: Process only those events that have 
previously been processed in error. 

Invalid Accounts: Process only those events that 
have previously been processed in error. Replace 
any invalid accounts with the suspense account. 

Default value is All. 

Report Style Users can choose to decide on the details of the 
report. The report can be printed in Summary, 
Detail, or No report. 

Default value is Summary. 

Transfer to General Ledger Indicates whether the Create Accounting process 
should submit the Transfer to GL process; Yes, No. 

Default value is Yes. 

Post in General Ledger Indicates if users want to submit General Ledger 
posting: Yes or No. 

Default value is No. 

Journal Batch Batch name used by Transfer to GL to decide on 
the batch name for the batch created in Oracle 
Fusion General Ledger. 

 

When a value for the batch name is not provided, 
journal import defaults will be used. 

 

This is a free text field. 
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Include User Transaction 
Identifier 

Default value is No. 

Table 15: Parameter to run Create Accounting Scheduled Process 

 

Note: To make sure that Invoices and Payments have been successfully transferred 
to General Ledger you need to run Create Accounting process with the Transfer to 
General Ledger option set to Yes to transfer any unaccounted transactions to General 
Ledger. Choose Accounting Mode Final. (Essential step for Period Closing)  

 

3. Click Submit 
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6.2 Month End Closing 

 

This topic cover for Oracle Payables Procedures for performing period-end closing in 
Payables. 

 

1. Complete and Approve All Transactions and Payments. 

• Ensure that all transactions are completed for the period you are closing. 

• Complete all invoices, credits, and prepayments. 

• Submit Import Payables Invoices process to import all interface records 

(spreadsheet usage). 

• If the import process rejects any records, review the import corrections spreadsheet 

and resubmit the import. 

• If invoice approval is enabled, approve all unapproved invoices. Depending on how 

your invoice options are set, validation or accounting may be required before you can 

approve invoices. 

• Resolve holds on invoices. 

• Validate invoices. 

• Complete all payment files and payment process requests. 

• Submit the Payables Invoice Register and the Payables Payment Register reports 

to obtain details about invoices and payments. 

• Submit the Apply Missing Conversion Rates process to apply missing rates to 

foreign currency invoices only. 

 

2. Reconcile Payments to Bank Statement Activity 

You must ensure that the bank statement lines for all bank statement that have been imported 
for a particular period have been reconciled with the payment that you have recorded in the 
Payments application. Ensure that payments are cleared if you account for payments at 
clearing. 

 

3. Transfer all approved invoices and payment to General Ledger 

Create accounting and transfer approved invoices and payments to the General Ledger. 

• Submit the Create Accounting process with the Transfer to General Ledger option 

set to Yes to account and transfer any unaccounted transactions to General Ledger. 

• Submit the Post Subledger Journal Entries process to transfer to General Ledger 

any transactions that were accounted in final mode, but that were not transferred. 

• Review the output reports generated by the Create Accounting and Post Subledger 

Journal Entries to General Ledger processes to view the subledger journal entries 

created and any errors that may have occurred. 

 

4. Submit the Payables Unaccounted Transactions and Sweep Report Process 

This report basically helps you to sweep the transactions that you were not able to complete 
(unvalidated invoices) in a particular period to the next month. So, the system will change the 
accounting date at the distribution level for all the unaccounted transactions to the first day of 
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the next month. If your accounting policies allow you to sweep the transactions to the next 
month and you are not able to resolve the issues in the current month, then you can submit 
the Sweep Transaction Accounting Events process to sweep the transactions to the next 
period. 

 

5. Close the Current Payables Period 

Close the current Payables period and review the Payables Period Close Exceptions report 
to view accounting events and journal entries that fail period close validation. It is automatically 
submitted when closing a Payables period if there are unprocessed accounting events or un-
transferred journal entries. The period can be re-opened if needed. 

 

6. Reconcile Payables Activity for the Period 

Reconcile Payables activity using the following reports. Except for the first one, these reports 
are submitted in the Scheduled Processes window. The Payables to Ledger 
Reconciliation report is described in more detail below. 

 

Name Description 

Payables to Ledger 
Reconciliation report 

Lists the transactions and journals posted to the General 
Ledger for open payables balances to facilitate the 
reconciliation of accounting and transactional data recorded in 
Payables, Subledger Accounting, and General Ledger. 

Payables Trial Balance 
report 

Lists and subtotals by supplier and liability account all unpaid 
and partially paid invoices. 

Payables Posted 
Invoice Register 

List accounting lines for invoices that have been transferred to 
the general ledger. 

Payables Posted 
Payment Register 

List accounting lines for payments that have been transferred 
to the general ledger. 
 

Journal Entries Report List detailed information about subledger and general ledger 
journal entries, including transactions that have been 
accounted with error or not transferred to General Ledger. 

Payables Open Items 
Revaluation report 

List changes in the value of open items, such as unpaid 
invoices and credit memos, due to conversion rate 
fluctuations. 

Table 16: List of Reports for Reconcile Payable Activity 
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7. Open the Next Payables Period 

Open the next period in Payables using the Manage Accounting Periods task in the Invoices 
work area to allow recording business as usual. 

To Manage Accounting Period on Payables 

1. Navigate to: Payables > Invoices/ Payment>Task> Manage Accounting Periods 

 

Figure 29: Navigation to Manage Accounting Period 

 

2. From Manage Accounting Period you can close or open period and see the status of 

the period. 

 

Figure 30: Manage Accounting Period Landing Page 
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8 REPORT SUBMISSION 

7.1 Standard Report 

Oracle Fusion Payables provides predefined reports that cover the following areas: 

• Invoices 

• Payments 

• Payables to Ledger Reconciliation 

• Period Close 

• Prepayments 

• Income Tax and Withholding 

Below are the tables that listed Standard Reports available in Payables. 

 

Name Description Type of Report 

Import Payables 
Invoices Report 

Report from the process that 
creates Payables invoices from 
invoice data in the open interface 
tables. Automatically generated by 
the Import Payables Invoices 
process. 

Oracle Business Intelligence 
Publisher 

Payables Credit 
Memo Matching 
Report 

Lists credit memos and debit 
memos for suppliers along with the 
invoices to which the credit memos 
and debit memos are matched. 

Oracle Transactional Business 
Intelligence 

Payables 
Invoice Aging 
Report 

Lists unpaid invoices according to 
the specified aging periods. 

Oracle Business Intelligence 
Publisher 

Supplier 
Balance Aging 
Report 

List the unpaid supplier invoices 
according to the specified aging 
periods. 

Oracle Business Intelligence 
Publisher 

Payables 
Invoice Audit by 
Voucher 
Number Listing 

Lists invoices with assigned 
sequential voucher numbers. 

Oracle Transactional Business 
Intelligence 

Payables 
Invoice Audit 
Listing 

Lists invoices for review and audit 
based on a specified amount for a 
given supplier and range of invoice 
creation dates. 

Oracle Transactional Business 
Intelligence 

Payables 
Invoice Register 

Provides detailed information about 
invoices. 

Oracle Business Intelligence 
Publisher and Oracle 
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Transactional Business 
Intelligence 

Payables Key 
Indicators 
Report 

Generates reports with transaction 
activity and the current number of 
suppliers, invoices, payments, and 
matching holds. 

Oracle Business Intelligence 
Publisher 

Payables 
Matched and 
Modified 
Receipts Report 

Identifies receipts that were 
modified after invoice matching. 

Oracle Business Intelligence 
Publisher 

Payables 
Matching Detail 
Report 

Provides details of how an invoice, 
purchase order, or receipt was 
matched. 

Oracle Business Intelligence 
Publisher 

Payables 
Matching Hold 
Detail Report 

Provides detailed payables and 
purchasing information for invoices 
with matching holds and matching 
hold releases. 

Oracle Business Intelligence 
Publisher 

Payables 
Negative 
Supplier 
Balance Report 

Lists suppliers with negative 
balances along with the invoices 
and credit or debit memo 
transactions for the balance. 

Oracle Transactional Business 
Intelligence 

Table 17: Standard Reports for Invoices 

 

Name Description Types of Report 

Payables 
Cash 
Requirement 
Report 

Forecasts immediate cash needs for 
invoice payments. 

Oracle Business Intelligence 
Publisher 

Payables 
Payment 
Requests 
Import 
Report 

List the payment requests for invoices 
that are imported or rejected with 
rejection reasons for payments. 

Oracle Business Intelligence 
Publisher 

Payables 
Discounts 
Taken and 
Lost Report 

Identifies payments where a discount 
was taken and payments where a 
discount was available, but not taken. 

Oracle Business Intelligence 
Publisher and Oracle 
Transactional Business 
Intelligence 
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Payables 
Payment 
Register 

Provides detailed information about 
payments. 

Oracle Business Intelligence 
Publisher and Oracle 
Transactional Business 
Intelligence 

Payables 
Selected 
Instalments 
Report 

Lists all invoice instalments selected in 
a payment process request to help 
determine how well the selection 
criteria is selecting the correct invoices 
to pay. 

Oracle Business Intelligence 
Publisher 

Payment 
Audit by 
Voucher 
Number 
Report 

Lists payments with assigned 
sequential voucher numbers. 

Oracle Business Intelligence 
Publisher 

Update 
Matured 
Bills Payable 
Status 

Report from the process that updates 
the status of matured bills payable from 
issued to negotiable. 

Oracle Business Intelligence 
Publisher 

Table 18: Standard Reports for Payment 

 

Name Description Types of Report 

Payables to 
Ledger 
Reconciliation 
Report 

Lists the journals posted to the general 
ledger for open payables balances to 
facilitate the reconciliation of 
accounting and transactional data 
recorded in Payables and Oracle 
Fusion Subledger Accounting. 

Oracle Transactional Business 
Intelligence 

Table 19: Standard Reports for Payables to Ledger Reconciliation 

 

Name Description Types of Report 

Payables 
Open Items 
Revaluation 
Report 

Lists changes in the value of open 
items, such as unpaid invoices and 
credit memos, due to conversion rate 
fluctuations. 

  

Oracle Business Intelligence 
Publisher 

Payables 
Period Close 
Exceptions 
Report 

Lists exceptions that prevent the 
Payables accounting period from 
closing. 

Oracle Business Intelligence 
Publisher 
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Payables 
Posted 
Invoice 
Register 

Lists accounting lines for invoices that 
have been transferred to the general 
ledger. 

Oracle Transactional Business 
Intelligence 

Payables 
Posted 
Payment 
Register 

Lists accounting lines for payments 
that have been transferred to the 
general ledger. 

Oracle Transactional Business 
Intelligence 

Payables 
Trial Balance 
Report 

Lists and subtotals by supplier and 
liability account, all unpaid and 
partially paid invoices that Payables 
transferred to the general ledger. 

Oracle Business Intelligence 
Publisher 

Payables 
Unaccounted 
Transactions 
and Sweep 
Report 

Lists invoices and payments that 
weren't accounted for a period or date 
range. 

  

Oracle Business Intelligence 
Publisher 

Table 20: Standard Reports for Period Close 

 

Name Description Types of Report 

Prepayment 
Remittance 
Notice 

Lists prepayments that were 
applied to supplier invoices. 

Oracle Business Intelligence 
Publisher 

Table 21: Standard Reports for Prepayments 

 

Name Description Types of Report 

Payables 
Withholding 
Tax by Tax 
Authority 
Report 

Lists withholding for tax codes assigned 
to a tax authority. 

Oracle Transactional Business 
Intelligence 

Payables 
Withholding 
Tax Letter 

Creates a withholding tax letter to mail to 
a supplier on a periodic basis. The letter 
contains a list of withholding made for a 
supplier summarized either by tax type 
and tax rate, or by supplier site. 

Oracle Business Intelligence 
Publisher 
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Payables 
Withholding 
Tax Report 

Lists withholding for a supplier. The 
invoice view is used to review detailed 
withholding tax information by invoice. 
The supplier view is used to review the 
withholding information for a range of 
suppliers. 

Oracle Transactional Business 
Intelligence 

Table 22: Standard Reports for Income Tax and Withholding 

 

For Oracle Business Intelligence Publisher reports, you can schedule and run reports from the 
Scheduled Processes work area. 

To Run Report from Schedules Processes 

Navigate to Tools> Schedules Processes 

1. Click on Schedule New Process. 

2. Leave the type as Job, enter the name of report you want to run, and click OK. 

3. In the Process Details dialog box, enter at least the required parameters, if any.  

 

For Oracle Transactional Business Intelligence, you can access and open reports in the 
Reports and Analytics work area. 

 

To Run Report from Reports & Analytics 

Navigate to Tools> Report and Analytics  

1. From the catalog folders or search results, open a report. 

2. Click the View Report icon if you want a different format. 

• Choose HTML or PDF to display the report in a format for printing. Because it's 
optimized for printing, PDF often provides the best results. 

• You can also export the report as RTF for editing in a word processor, or as 
Excel or PowerPoint. 

3. From the catalog folders or search results, you can also do these tasks: 

• Click Edit to edit the report properties, layout, and data model. 

• Click Report History to see details about past submissions of the report. 

• Click Schedule to schedule the report to be run. 

 

For some Invoices and Payment Report & Analytics, you can run it through Invoice Page or 
Payment Page in Payables. 

 

To Run Report through Payables 

 

1. For Invoices, Navigate to Payables> Invoices> Report and Analytics  

For Payment, Navigate to Payables> Payment >Report and Analytics  
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Figure 31: Navigation to Run Report from a) Invoice Page and b) Payment Page 

 

2. From the catalog folders or search results, click on the chosen report and system will 

prompt report action screen box 

 

 

 

 

 

 

Figure 32: Report Action Screen Box 

 

Action Description 

Edit To view or edit the report. 

Schedule To run schedule process for 
the report. 

Edit 

Schedule 

History 

More 

a) b) 

 

Report and Analytics 
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History To see the Job History of the 
Report. 

More This will navigate you to 
Oracle Transactional 
Business Intelligence Page  

Table 24: Report Action Screen Box Description 
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9 PAYABLES MAINTENANCE SETUP 

 

After the initial setup, if there are any changes needed it can be done via Setup and 
Maintenance. 

To get into Setup and Maintenance 

Navigate to Others > Setup and Maintenance 

 

8.1 Maintain Payment Document 

Payment Documents are defined for an internal bank account for payment number sequence. 
No invoices can be pay with the bank without creating payment document for the invoice. 
Examples of payment documents are checks or electronic payments. You must create at least 
one payment document before you can use a bank account to create invoice payments. You 
can create an unlimited number of payment documents for an internal bank account. 

 

To Navigate to Payment Document 

1. From Setup and Maintenance > Cash Managements and Banking> Manage Bank 

Account 

 

Figure 33: Navigation to Payment Document 

 

2. In the Manage Bank Accounts window, query for the disbursement bank account by 

entering one of the required fields. 

3. Click Search 

4. Choose the Bank Accounts which you want to create or edit the Payment Document. 

5. Click Edit 

6. Go down to Payment Document, click  to Create/ Add Payment Document or  

to View/ Edit Payment Document, 
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Figure 34: Payment Document List for Chosen Bank Account 

 

 

Figure 35: Create Payment Document Page 

 

To create a payment document 

1. Enter a Name for the payment document that is unique for the bank account.  

2. Select a Payment Format.  

3. Enter Paper Stock Type Options 

Blank Stock: - Select blank stock if you are creating payment document for payment 

method checks. 

Prenumbered Stock: - Select this type if you are going to do payment through 

electronic payment method.  

4. You can also specify; maximum number of invoices will be paid through single 

payment/check with this number of lines per remittance stub field option. 

5. You must give the sequence of the payment document number from which your 

payment number will be start in Document Number Field. In checks, you can start the 

sequence number same with your current check book given by the bank. 

6. Click Save. 

To edit the payment document, click on , do any changes needed to the payment 
document in the fields described as above, Save your work. 
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To inactivate a payment document: 

1. For the payment document you want to inactivate, enter an Inactive Date, the date on 

which this payment document will no longer be available for use. When you create a 

payment on or after this date you will no longer see this payment document in a list of 

values. 

2. Save your work. 

 

8.2 Maintain Distribution Sets 

You can use a Distribution Set to automatically enter distributions for an invoice when you are 
not matching it to a purchase order.  

You can assign a default Distribution Set to a supplier site so Payables will use it for every 
invoice you enter for that supplier site. If you do not assign a default Distribution Set to a 
supplier site, you can always assign a Distribution Set to an invoice when you enter it. 

Use Full Distribution Sets to create distributions with set percentage amounts or Skeleton 
Distribution Sets to create distributions with no set distribution amounts 

 

From Setup and Maintenance > Payables> Manage Distribution Set 

 

Figure 36: Create Distribution Set Page 

 

To Create Distribution Set 

1. In the Distribution Sets window, enter Business Unit 

2. Enter the Name and Description of the Distribution Set you are creating. 

3. Enter the Distribution Percentage. Select 0 to enter amounts manually during invoice 

entry. Select 100 to use percentages for distributing amounts across distribution 

combinations. 

4. Enter the Account and Description for each distribution along with Distribution 

Combination and enter the Percentage of the invoice amount that you want to 

distribute to the Account. You can enter positive and negative percentages. Create as 

many distributions as you need. The sum of the distribution percentages must equal 

100 or 0. 

5. Click Save. Payables automatically assigns type Full to your Distribution Set if you set 

percentage to 100 and Skeleton if you choose 0 in Distribution Percentage. 

To Edit Distribution Set, just choose the distribution set you would like to edit in the list, make 
your changes and save your work. 
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8.3 Maintain Payment Terms 

Payment terms are used to automatically create invoice installments. You can define payment 
terms to create multiple installments and multiple levels of discounts. 

Payment terms consist of one or more lines, each of which creates one invoice installment. 
When you define a payment term, you can specify either percentages or fixed amounts. A 
payment term line can have up to three discounts. Each line and corresponding installment 
have a due date and up to three discount dates. Each line and corresponding installment also 
have due or discount amounts. You can assign a payment term to one or more sets to share 
that payment term across business units. 

 

Payment Terms Due Dates and Discount Dates 

Payment terms due dates and discount dates are based on one of the following methods: 

1. Fixed Date: A specific day, month, and year that an installment is due for payment. 

2. Days: A number of days added to the invoice terms date. 

3. Calendar: A Payables calendar that's divided into periods. You can assign a due date to 

the period that includes the invoice terms date. You can assign due dates to avoid 

weekends, holidays, and so on. You can't assign calendar-based terms to an invoice if a 

period isn't defined for the terms date. 

4. Day of Month: A type of payment term with the following attributes: 

 

a) Day of Month: A specific day of the month when an installment is due for payment. For 

example, enter 15 to schedule payment on the fifteenth day of the month. Enter 31 to 

schedule payment for the last day of the month, including months with less than 31 

days. 

b) Cutoff Day: The day of the month after which the installment due and discount dates 

advance to a future month. If you don't specify a cutoff day, the current accounting 

month is used to determine due and discount dates. 

c) Months Ahead: The number that's used to determine the month the installment is due. 

If you enter 0 and the terms date is the same as, or later than, the cutoff day, the 

installment is due the following month. 

 

For example, a payment term has a Cutoff Day of 11, the Day of Month is 15, and Months 
Ahead is 0. If you enter an invoice with a terms date of January 12, the installment is due 
February 15. If you enter an invoice with a terms date of January 10, the installment is due 
January 15. If the terms date is January 12 and Months Ahead is set to 1, the installment 
is due March 15. 

Note: Only due dates, not discount dates, can be based on a calendar. 
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From Setup and Maintenance > Payables> Manage Payment Terms 

 

Figure 36: Create Payment Terms Page 

 

To Create Payment Terms Set 

1. Enter the Name and Description of the payment terms you are creating. 

2. Enter the From Date for the Payment Terms. 

3. Click on + button to add the installments information. 

4. Enter Due percentage. Set it as 100. 

5. Enter the Days as for the aging calculation days. 

6. Click on + button to add the Set Assignment. 

7. Assign set code as Common for Common Set. This allows you to use the payment 

term across any reference set. (Dependency on Business Unit Assignment Setup) 

8. You may skip other fields for discount. 

9. Click Save. The Payment Term is now available to use on the invoice.  

To Edit Payment Terms, just choose the any of payment terms you would like to edit in the 
list, make your changes and save your work. 

 

8.4 Maintain Payment Voucher Sequencing 

Assigning unique document numbers to documents is called document sequencing. You can 
assign sequential numbers to each invoice and payment in your Payables system to ensure 
that you have a unique number for each document. If you use sequential numbers, you can 
confirm that no document has been lost. Even if invoices or payments are deleted, each 
voucher number retains audit records. You can also maintain an audit trail because you can 
trace a journal entry back to the original document in Payables. 

When setting up document sequencing, you select a set of numbers, called a sequence, that 
you will assign to a type of document. The type of document is called a document category.  

You can define any number of Document Sequences. You can assign the same Document 
Sequence to more than one combination if the Application and Category are the same in the 
combinations. For example, you can also assign the same automatic numbering sequence to 
documents you enter both manually and automatically. 
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To Manage Payables Document Sequence 

1. From Setup and Maintenance> Payables> Manage Payables Document 

Sequences 

2. To search for Payables Application Document sequences, enter Payable is module 

Field. Click Search. 

3. The list of Document Sequences will be shown, and you can Create  a new 

Document Sequence or inactivate Unused Document Sequences from this page. 

 

Figure 38: Manage Payables Document Sequences Page 

 

To create New Document Sequence 

1. Click Add 

2. Enter Document Sequence Name  

3. Enter Application: Payables in this case 

4. Enter Module: Choose from drop down list 

5. Enter Type: Either automatic, manual or gapless 

6. Enter Determinant Type: Choose Legal Entity from dropdown list as determinant type 

for all document sequence. 

7. Enter Start Date 

8. Click Expand: Enter Initial Value and the Last Number. You can also choose to enable 

audit & display message. 

9. Specifying assignment: Assign the sequence to document category. You can add more 

than one document category per sequence. 

10. Save you work. 

When you create and save a sequence, you cannot change it. When you save it, a 
concurrent process starts that automatically generates the sequence. Wait until this 
process completes successfully before continuing with assigning the sequences to a 
category. 

Attention: Do not use voucher numbers that exceed nine digits. If your voucher number 
exceeds nine digits in Payables, then Payables cannot process the document. 
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Notes: LSE AP document sequence will be based on the AP Invoices and Payment 
Methods. This manual document is mainly general step guide. It is advisable and much 
more convenient for you to refer and follow formatting based on existed document 
sequence created during implementation. The document sequence also recorded in 
the LSE Configuration Workbook_Payables. 
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**end of document** 


